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Getting Started 

Introduction to EDEM 

EDEMTM is a DEM (Discrete Element Method) simulation software platform designed for 
the simulation and analysis of bulk particle handling and processing operations. 
 
With EDEM you can quickly and easily create a parameterized model of your bulk solids 
system. CAD models of real particles can be imported to obtain an accurate 
representation of their shape. Add the mechanical, material and other physical properties 
to form your model particles. These can be stored in a library allowing you to build a 
collection specific to your processes. 
 
EDEM manages information about each individual particle (mass, velocity and so on) 
and the forces acting on it. It can also take into account the particle’s shape, rather than 
assuming that all particles are spherical. For post-processing, EDEM provides data 
analysis tools, 3D visualizations of the particle flow, and video creation. 
 
EDEM's Particle FactoryTM technology provides a unique method for efficiently 
generating assemblies of particles in association with the machine geometry imported 
from your CAD or CAE system as a solid model or mesh. Machine components can be 
grouped, moved, and copied; and you can specify the kinematics of each group 
individually. 
 
User Defined Libraries programmed in C++ using EDEM’s API (Applications 
Programming Interface) enable extension of EDEM’s default physics capability to 
simulate almost any particle-particle, particle-fluid, particle-structure, or particle-
electromagnetic interaction using external models, custom, or third-party solvers.  
 
With EDEM’s powerful post-processing tools you can visualize and graph any 
combination of variables. Having identified important system behavior you can easily 
modify models to refine your simulation. You can then use the video export feature to 
create video files of your simulation. EDEM can even record multiple simulations in the 
same video. 
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EDEM User Interface  

EDEM is made up of three sections: the Creator, the Simulator and the Analyst. 

  Creator – set up and initialize models 

  Simulator – configure and control the EDEM solver engine 

  Analyst – EDEM’s data analysis and visualization tool 
 

You can move between each section by clicking on the toolbar button indicated above. 
 

The layout of the user interface is common to each section. It consists of: the Tabs 
Pane, the Viewer, the Viewer Controls and the Data Browser. 
 

 

 The Tabs Pane 

The Tabs Pane is displayed at the on the left side of the EDEM window. It is made up of 
a number of individual panes. The contents of each pane vary according to which 
section of EDEM is currently active. 
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 The Viewer 

The Viewer displays 3D representations of your particles and geometry. The 
orientation, position and zoom factor of the Viewer are controlled using the 
mouse. The arrows in the bottom-left corner of the viewer indicate the 
current orientation: red (x), green (y) and blue (z). 
 
See Camera and Mouse Actions on page 9 for more details. 

 The Viewer Controls  

The Viewer Controls are used to determine how items are displayed in the Viewer: For 
example, the fill-style of a particle or the opacity of a geometry. The content of the pane 
varies according to which section of EDEM is currently active. 

 The Data Browser  

The Data Browser is an .html page that displays detailed information about the contents 
of the Viewer: For example, particle properties and interactions or the dimensions of a 
geometry section. The content of the page varies according to which section of EDEM is 
currently active. 

Arranging the User Interface  

Floating and Docked Panes 

The Tabs pane, Viewer controls and Data browser can each be floating or docked. By 
default all panes are docked. To undock a pane double click on its title bar (control area) 
and place it anywhere in screen. Double click the title bar to re-dock it in its original 
position or drop it over the left or right edge or the bottom of the screen to dock it in that 
position. 

Opening and Closing Panes 

Right-click anywhere on the toolbar. Each of the panes is listed. Select or un-select a 
pane to open or close it. In addition each pane can be closed using the close button 
displayed on its title bar.  
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Camera and Mouse Actions 

Use the mouse (with modifier keys) to move the camera around the model in the viewer. 
You can pan, track, zoom and rotate the camera. Select Tools > Options and then the 
Mouse Configuration tab to configure these controls. See the Creator Tools menu on 
page 19 for details. 
 
Pan 
 

  

Press and hold the left mouse button. Drag the pointer to pan (alter) the position. The 
object follows the cursor. 

 
Free Rotate 
 

  

Press and hold the right mouse button to 
rotate. 

 

 
Track 
 

Track lets you move the camera while keeping a fixed distance from the target. This can 
be useful to track objects that may be hidden behind other objects. Usually, when you 
zoom in to an object the camera stops at the target position. To maintain the same 
distance between the camera and the target, hold down the shift key then use the left 
mouse button to track. 
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Zoom 
 

  

Use the mouse’s scroll wheel to zoom in and 
out (or press and hold the middle mouse button 
and move the mouse back and forth). 

 

 
Zoom to Box 

Alternatively, while holding down the Ctrl button, press and hold the middle mouse button to draw 
a box to zoom to: 
 

 
 

Drag the selection around the area to zoom to. 

 

Drag the selection around the area to zoom to. 

 

Release the middle mouse button to perform 
the zoom. 
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Rotate on Axis: Screen Axis 

Select Tools > Options > Mouse Configuration and select to rotate on the Screen Axis. The 
screen’s axes are shown below as dotted lines. 
 

  

With the Shift key held down, press and hold 
the right mouse button to lock the axis.  

Move the mouse right to rotate the object 
around the screen’s right vector.  

 
Rotate on Axis: Model Axis 

Select Tools > Options > Mouse Configuration and select to rotate on the Model Axis. The 
model’s right axis is shown below as a dotted line. 
 

  

With the Shift key held down, press and hold 
the right mouse button to lock the axis. 

Move the mouse up to rotate the object around 
the model’s axis closest to the up vector. 
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Choosing Units  

The units of measurement used throughout EDEM can be configured. By default all 
quantities are measured in standard SI units (Système International d'Unites). 

Changing Units 

Select Tools > Options > Units to change the units. Changes are propagated throughout 
the software*. You can set units individually. Alternatively, all units can be set to CGS 
(centimeter-gram-second) or back to the default SI. 
 

Property Units available SI unit CGS unit 

Acceleration mm/s2, cm/s2, m/s2, in/s2, ft/s2, fpm/s m/s2 cm/s2 

Angle rad, deg rad  rad 

Angular Acceleration rad/s2, deg/s2 rad/s2 rad/s2 

Angular Velocity rad/s, deg/s, rpm rad/s rad/s 

Charge nC, C C C 

Density g/cm3, kg/m3, lb/in3, lb/ft3, slug/ft3 kg/m3 g/cm3 

Energy J, erg, kwh, btu, ft-lbf, in-lbf J erg 

Force N, dyn, kgf, lbf, ozf, pdl, gf N dyn 

Frequency Hz, kHz, mHz Hz Hz 

Heat Flux W, J/S W W 

Length mm, cm, m, in, ft m cm 

Mass mg, g, kg, lb, oz kg g 

Mass Generation 
Rate 

mg/s, g/s, kg/s, lb/s, oz/s, mg/min, 
g/min, kg/min, lb/min, oz/min, kg/h, 
uk ton/h, us ton/h, metric tonne/h 

kg/s g/s 

Moment of Inertia lb/ft2, kg/m2, g/cm2, lb/in2, slug/ft2 kg/m2 g/cm2 

Shear Modulus pa, ksi pa pa 

Stiffness N/m, lb/ft N/m N/m 

Stress pa, Nm2, lb/in2 pa pa 

Temperature K, oC, oF K K 

Time s, min s s 

Torque Nm, Dyne.cm, gf-cm, kgf-m, lbf-in, 
lbf-ft 

Nm Dyne.cm 

Velocity mm/s, cm/s, m/s, in/s, ft/s, ft/min m/s cm/s 

Volume mm3, cm3, m3, in3, ft3, L m3 cm3 

Work Function J, eV J J 

 

* Note: Graphs are not automatically updated when units are changed. Once units have 
been changed, click the 'Create Graph' button to regenerate graphs. 
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Managing Licenses 

EDEM uses a software license management system called SentinelTM RMS to manage 
licenses. As part of the EDEM installation process, licensing software is installed either 
on the same machine as EDEM or on a license server machine on your network. 

Specifying the License Server to Use 

When you start EDEM for the first time, a popup window is displayed for you to specify 
which license server to use. 

 Select a license server (or click Refresh to refresh the list) then click OK.  
 To change to a different license server, start EDEM using the License Server 

Reset option from the Start menu. 

You can also specify the license server from the command line. For example, to start 
EDEM and use a license server called HERACLES, type the following command: 

edem.exe –-server HERACLES 

To view the popup window with the list of license servers, from the command line type: 

edem.exe –-server 

License Features 

An EDEM license consists of a number of license features. These determine which 
EDEM features are available to you. Every license has at least two features: an 
EDEMCore and an EDEMCPU feature. The EDEMCore feature lets you start and use 
EDEM. The EDEMCPU feature controls how many processors are available to use to 
run a simulation. Depending on what was purchased, your license server may also have 
other features. 

EDEM communicates with Sentinel RMS automatically whenever it needs a license 
feature. You can also reserve features in advance using the EDEM License Manager. 
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EDEM License Manager 

The EDEM License Manager lets you reserve (“Check-Out”) license features as well as 
work offline (when you have purchased the commuter feature) to use EDEM when 
disconnected from the license server.  

To view the EDEM License Manager, select Tools > License Management: 
 

 
 
License features available from the license server are shown in the Network Features 
area on the right. Local features currently being used are shown in the Client Features 
area on the left. For each license feature, the EDEM License Manager shows how many 
are available, how many are currently being used, and how many are commuted. For 
any selected feature, the lower panes show the start date, expiry date, host name and 
check out time (if applicable). 
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EDEM Creator 

About the EDEM Creator  

The EDEM Creator is used to setup and initialize your model. Create or import particles 
and geometry and define the other model parameters. 
 

 
 

 Tabs Pane 

 Viewer 

 Viewer Controls 

 Data Browser 

 Toolbar and Menu bar 
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Tabs Pane  

The Tabs Pane is displayed at the on the left side of the EDEM window. It contains four 
tabs: Globals, Particles, Geometry, and Factories. 

Viewer 

The Viewer displays 3D representations of your particles, geometry, and fields (if 
applicable). The rotation, position and zoom factor of the Viewer are controlled using the 
mouse. 

Viewer Controls (Creator)  

The Viewer Controls are used to determine how items are displayed in the Viewer. The 
content of the pane varies according to which tab in the Tabs pane is currently active. 

Current Time 

Lists all full time steps in the simulation. The selected time step is displayed in the 
Viewer. 

View 

Controls to change, add, and configure camera views. 

 Select a view from the pulldown menu to display the Viewer from a number of 
different angles.  

 To create a custom view, position your model as required then click the + button. 
Click the configure button to modify the view’s projection, lighting, and other 
settings. Click the view’s name to rename it, or click the x button to delete. 

 For any view, if you manually change the angle or view configuration you can 
return to the original angle and settings by clicking the reset button. 

 Click the configure button to open the Configure View window: 
 

Setting Description 

Projection Set the projection type to either Perspective or Orthographic.  

 Perspective Projection displays objects as they would appear 
in the real world: objects that are further appear smaller. 

 Orthographic Projection maps objects without affecting their 
relative sizes. Unlike perspective projection, with orthographic 
projection the size of the viewing area does not change from 
one end to the other. In other words, the distance from the 
camera does not affect how large an object appears. This is 
useful in architectural and CAD applications where the final 
image needs to reflect the measurements of objects, rather 
than how they might look. 

Field of View For perspective projection, set the angular field of view. 

Camera Position Specify the X, Y, and Z coordinates to determine the position of 
the camera. 
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Target Position The target is the location of the point the camera is looking at. 
Specify the X, Y, and Z coordinates to determine the position of 
the target. Click the Domain Center button to place the target at 
the center of the domain. 

Up Vector The Up Vector indicates to the camera which way is up. Specify 
the camera’s Up Vector using either world coordinates or by using 
the dial control. 

Specular 
Reflection 

EDEM’s headlight is a constant lighting effect shining from the 
camera. It combines with a specular reflection technique to shade 
displayed objects. When the headlight is perpendicular to a flat 
geometry plane, the plane can become too shiny to be 
distinguished from the background. Click the checkbox to enable 
or disable the headlight’s specular reflection. Specular reflection is 
disabled by default for all views except the Default view. 

Import/Export Allows customized camera settings created in one simulation 
deck to be saved for importing into future simulations. Use the 
Export button to save camera settings to a file (no file extension is 
required). Use the Import button to load all custom views in a file. 
Custom views can be imported into the Creator, Simulator, and 
Analyst, but must be imported into each section individually.  

 

Geometry 

 Display mode. Configure the display of all the geometry in the Viewer. Choose 
between filled, mesh or points style display.  

 Opacity. Configure the opacity level of all the geometry in the Viewer. 

Particles 

 Show Particles. Display particles already created by the Simulator. 

 Show Scale Grid. Enable or disable the display of a grid around the particle. 

 Show Origin. Displays the origin. All multi-sphere particles must be centered on 
the origin. 

 Highlight Surface. Highlight the currently selected particle surface.  

 Show Template. Used to display particle templates in the Viewer. 

Fields 

 Display field. Select a field from the pick-list then tick to enable or disable 
display of the field in the viewer. Vector fields are displayed as arrows; scalar 
fields are displayed as points. 

 Color. Select a color to display the field as. The default is Blue. 

 Scale. Set the length of the field’s vector line. 

Factories 

 Display Lattice. Enable or disable the display of the particle positioning lattice. 
This option is only available when cubic, BCC or FCC lattice positioning is 
selected. 
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Data Browser (Creator)  

The Data Browser is an .html page that displays detailed information about your model. 
The information displayed differs between the Creator, Simulator and Analyst. Right click 
in the Data Browser and choose Save to save the information in an .html file. 
 
There are five sections in the Data Browser within the Creator: 

Description 

The description as defined in the Globals tab. 

General 

 Dimensions. The number of dimensions in your domain. 

 Gravity. Details of the gravity acting in your model as specified in the Globals 
tab. 

 Materials. A list of all materials used in the model and their properties, as 
specified in the Materials Editor. 

 Energy. The total energy in the model at the current time. It is the sum of the 
kinetic energy, potential energy and the energy in any contacts taking place. 

Geometry 

 Domain. The dimensions of the domain as specified in the Geometry tab. 

 Geometry Totals. Details of the number of elements that make up each section 
of geometry. 

 Sections. Each section is the model and its properties are listed. Properties are 
as specified in the Geometry tab. 

Particles 

 Particles. A list of each particle type used in the model and their properties. 
Details of each surface within the particle are also listed. Properties are as 
specified in the Particles tab. 

 Factories. Details of each factory used in the model and their properties. 
Properties are as specified in the Factory tab. The total number of particles 
created by each factory is also listed. 

 Particle totals. The total number of particles in the model at the current time. 
Totals for each particle type are also listed. 

Contacts 

 Interactions. A list of the interaction types taking place in the model as specified 
in the Materials Editor. 

 Contacts. Lists the total number of contacts in progress at the current time. The 
contacts are broken down into contact types: For example number of particle A - 
particle B contacts or number of particle B - surface A contacts. The total number 
of collisions that have taken place during the time step are also listed. 
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Creator Toolbar  

Icon Name Description 

 Creator Click to switch to the Creator. 

 Simulator Click to switch to the Simulator. 

 Analyst Click to switch to the Analyst. 

 New Click to start a new model. 

 Open Click to open an existing model. 

 Save Click to save your model. 

 Help Click to view the online help. 

 

Creator Menu Bar 

File Menu 

 Open. Open an existing model 

 New. Start a new model. 

 Save. Save the current model. 

 Save As. Save the current model with a specific name or to a specific location. 

 Creator. Select to switch to the Creator. 

 Simulator. Select to switch to the Simulator. 

 Analyst. Select to switch to the Analyst. 

 Recent Files. A list of recently opened files. Select a file to open it. 

 Quit. Quit EDEM. 
 

Tools Menu 

Materials Database 

Access the Materials Database. See The Materials Database on page 28. 

License Management 

Access the License Management tools to reserve licensable features and manage 
commuter licenses. See Managing Licenses on page 13. 

Options  

Access the global options dialog containing settings for the following items. 

Particle Display 
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 Display Templates. Mesh files created in other packages can be used as 
particle templates. Templates can be used as a guide (outline) to help define 
the shape of your particle in the Creator as well as provide, if desired, the 
shape for calculation of the center of gravity and mass moments of inertia, or 
as a display option in the Analyst.  

Refer to Appendix C: EDEM File Types on page 122 for a list of file-types that 
can be imported. When a model containing a particle template is saved, an 
extra file (.ptf) is created alongside the usual three files (.dem, .dfg and .idx). 
If this file is deleted, the template information will no longer be stored within 
the model. 

 
Figure 2-1: Default Particle Display 

 
Figure 2-2: Particle Display Using a Template 

Mouse Configuration 

Used to configure how the mouse is used to alter the display in the Viewer.  

 Camera Actions. Change the mouse button and modifier key used to 
pan, track, zoom and rotate the camera. Modifier keys assign keyboard 
buttons to press to perform the specified camera action. Choose any 
unique combination of three mouse buttons and three keys for each 
motion. 

 Rotate on Axis. Change the mouse button and modifier key used to 
rotate on an axis. You can also set whether to rotate on the model axis or 
the screen axis for both the horizontal and vertical rotations. 

 Mouse Sensitivity. The mouse sensitivity can be altered independently 
for tracking and zooming. You can also specify modifier keys for each 
sensitivity setting. 

See Camera and Mouse Actions on page 9 for more information. 

File Locations 

The file location options are used to determine the location of the materials 
database 
and any user-defined elements. 

 Materials Database. The location of the materials database, used to 
define any material used in a model. See The Materials Database on 
page 28. 
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 Contact Models. The location of custom (user-defined) contact models. 
See the user section of the DEM website. 

 Particle Body (External) Force. The location of custom (user-defined) 
forces. See the user section of the DEM website. 

 Particles. The location of particles saved independently of the model for 
reuse in other projects. 

 Factories. The location of any user-defined factories. 

Background 

This option is used to change the fill color of the Viewer background. The 
background can be colored with a solid or gradient fill. The color change will 
affect the Creator, Simulator and Analyst. 

Units 

The units configuration dialog is used to set the measurement units used 
throughout EDEM. See Choosing Units on page 12 for more details. 

Data Browser 

The data browser options are used to configure the color of the data browser text 
and background. 

Analyst Options 

 Timestep: Models can be loaded into the Analyst with the first or last time 
step appearing first.  

 Axis Key: Turn the display of the axis key in the Viewer on or off. 

 Bounding Box: Turn the display of the boundary box (marking the 
domain edges) in the Viewer on or off. 

 Timestamp: Turn the display of the time stamp in the Viewer on or off. 

 

Global Settings 

Simulation 

Set the simulation title and a description of the simulation. 

Physics 

Interaction 

Select the type of physics interaction to add: 

 Particle-to-Particle contact models 
 Particle-to-Geometry contact models 
 Particle Body Forces 

Contact Models 
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A contact model describes how elements behave when they come into contact with each 

other. Using the Interaction pulldown menu and + pick-list, you can build a list (stack) of 

contact models. The top element is applied first, then the next one down and so on. Use 
the up and down buttons to move the contact model up and down the list (check the 
sections below since some models need to be at the start or end of the list). To remove 

an item, click the x button. Click the preferences button to configure the selected model. 

Every simulation must have at least one base particle-to-particle and one particle-to-
geometry contact model. EDEM is supplied with several integrated contact models; you 
can also add your own custom plug-in contact models. Refer to the user section of the 
DEM website and the EDEM Programming Guide for details. 

Hertz-Mindlin (no slip)  

Hertz-Mindlin (no slip) is the default contact model. 
 

Interaction Configurable Parameters Position 

Particle to Particle, 
Particle to Geometry 

None. Last 

 

Hertz-Mindlin (no slip) with RVD Rolling Friction 

Hertz-Mindlin (no slip) with RVD Rolling Friction calculates contact forces in the same 
way as the Hertz-Mindlin (no slip) model, but offers an alternative implementation of 
rolling frictions at contacts. Since this model includes Hertz-Mindlin, remove the default 
no-slip contact model from the list. 
 

Interaction Configurable Parameters Position 

Particle to Particle, 
Particle to Geometry 

None. Last 

 

Hertz-Mindlin with Heat Conduction 

Hertz-Mindlin with Heat Conduction calculates the heat flux between particles in contact. 
The model calculates a heat flux based on the particle temperatures and their overlap. 
This model must be used with Update Temperature particle body force to complete the 
calculation. The Update Temperature particle body force allows the inclusion of an 
external heat source and is where each particle temperature is calculated based on the 
heat flux calculated in the contact model and a given external heat flux. 
 

Make sure the Update Temperature particle body force model is added to the particle 
body force model. Since this model includes Hertz-Mindlin, remove the default no-slip 
contact model from the list. 

 

Interaction Configurable Parameters Position 

Particle to Particle Set the thermal conductivity for each type of particle.  

Note the unit depends on the temperature unit; for example, the 

Last 
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Interaction Configurable Parameters Position 

unit will be W/mK when the temperature unit is Kelvins. 

 

Hertz-Mindlin with Bonding 

Hertz-Mindlin with Bonding bonds particles together. Since this model includes Hertz-
Mindlin, you should remove the default no-slip contact model from the list.  

To use, enable the bonding model for both particle-particle and particle-geometry 
interactions. Although particles cannot be bonded to geometry elements, the bonded 
model ensures that the particles contact the geometry based on the particle’s physical 
radius and not the contact radius. 

 

Interaction Configurable Parameters Position 

Particle to Particle 
(also enable for 
Particle to 
Geometry) 

Select an active bond then set the Bond Formation Time and 
the following parameters: 

 Normal Stiffness: the tensile/compressive stiffness along 
the bond’s principal axis 

 Shear Stiffness: Shear stiffness in the orthogonal plane to 
the bond’s principal axis 

 Critical Normal Stress: the maximum normal stress the 
bond can withstand before it fails 

 Critical Shear Stress: The maximum tangential stress the 
bond can withstand before it fails 

 Bonded Disk Radius: The radius of the cylindrical bond 
between the particles 

Set the bond stress and stiffness values to represent the 
material that is been modeled. A high stiffness value will 
produce high bond forces and stresses.  A lower than normal 
timestep may be required to accurately capture these high 
forces. 

When the Bond Formation Time is reached, all defined 
particles in contact will be bonded together.  Before this time, 
particles interact based on the Hertz-Mindlin contact model. 

The bond formation time can be updated to restart the bonding 
process. Existing bonds won't be affected, but any unbonded 
particles in contact will be bonded whenever the updated bond 
formation time is reached. 

Note that a bond between two particles will cease to exist 
whenever one or both of the bonded particles leaves the 
simulation domain.  If periodic boundaries are applied when 
the particle leaves the domain, then the particle will exist on 
the opposite side of the domain; in this case the two particles 
will remain bonded across the periodic boundary. 

Last 

 

Hertz-Mindlin with JKR Cohesion 

Hertz-Mindlin with JKR (Johnson-Kendall-Roberts) Cohesion is a contact model that 
allows users to represent the cohesive nature of fine and moist materials. Originally 
implemented to allow the simulation of Van der Waals forces which influence the flow 
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behavior or fine, dry powders. This model may also be used to recreate the influence 
that a moisture content has on the bulk flow of larger-scale materials such as iron ore or 
wet grains. Remove the Hertz-Mindlin (no slip) contact model from the list when using 
this model.  
 

Interaction Configurable Parameters Position 

Particle to Particle, 
Particle to Geometry 

Click + to add cohesion to particle-particle or particle-geometry 
interactions. Set the surface energy for each interaction. 

Last 

 

Use 

1. Select the required category from the Interaction pulldown in the Physics section 
of the Creator. 

2. Click the + drop-down list then select Hertz-Mindlin with JKR Cohesion. 

3. Click the configuration button  to define contact model parameters.  
 

Linear Cohesion 

Linear Cohesion is a cohesion contact model that modifies the default Hertz-Mindlin 
contact model for particle-particle and particle-geometry interaction by adding a normal 
cohesion force. 
 
 

Interaction Configurable Parameters Position 

Particle to Particle, 
Particle to Geometry 

Click + to add cohesion to particle-particle or particle-geometry 
interactions. Set the energy density for each interaction. 

Any 

Use 

1. Select the required category from the Interaction pulldown in the Physics section 
of the Creator. 

2. Be sure a model for contact forces is listed in the Model section. If not, click the + 
drop-down list then select (for example) Hertz-Mindlin (no-slip). 

3. Click the + drop-down list then select Linear Cohesion. 

4. Click the configuration button  to define contact model parameters.  

 

Linear Spring 

Linear Spring is a damped linear spring contact force model. Remove the default Hertz-
Mindlin (no-slip) contact model from the list when using this model.  

 

Interaction Configurable Parameters Position 

Particle to Particle, 
Particle to Geometry 

Set the characteristic velocity of the spring. Be sure the velocity 
is the same for both particle-to-particle and particle-to-

Last 
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Interaction Configurable Parameters Position 

geometry. 

Use 

1. Select the required particle interaction from the Interaction pulldown in the 
Physics section of the Creator. 

2. Click the + drop-down list then select Linear Spring. 

3. Click the configuration button  to define contact model parameters.  

 

Hysteretic Spring 

The Hysteretic Spring model allows plastic deformation behaviors to be included in the 
contact mechanics equations, resulting in elastic-plastic deformation behavior. Unlike the 
Hertz-Mindlin and Linear Spring models, which are elastic contact models, with the 
Hysteretic Spring model particles behave in an elastic manner up to a predefined stress. 
Once this stress is exceeded, the particles behave as though undergoing plastic 
deformation. The result is that large overlaps are achievable without excessive forces 
acting upon them, thus representing a compressible material.  

When using this model the user should be aware that the coefficient of restitution 
parameter set in the interaction section of general tab is now used in an entirely different 
energy dissipation method compared to default Hertz-Mindlin model. The coefficient of 
restitution here determines the fraction of energy stored during loading energy which can 
be recovered upon unloading, Lower values of this parameter provide higher residual 
deformation in material under confinement. 
 
Remove the default Hertz-Mindlin (no slip) contact model from the list when using this 
model. 

 

Interaction Configurable Parameters Position 

Particle to Particle, 
Particle to Geometry 

Click + to add particle-particle or particle-geometry interactions. 
Set the following interaction parameters: 

 Damping factor: this dimensionless parameter controls 
the amount of velocity dependent damping. Without this 
additional damping, small vibrations of particles can 
persist for a long time. Setting this parameter to zero 
suppresses only the velocity-dependent damping 
without affecting the main energy loss mechanism due 
to the nature of the linearized elasto-plastic model. The 
recommended value for this parameter is zero when 
modeling  “aggressive” compression of materials and 
small non-zero value for  small stain compression 
regimes. 

 Stiffness factor: This dimensionless parameter is 
defined as the ratio of tangential stiffness to normal 
loading stiffness and used in calculation of tangential 
forces at the contact. According to the literature, the 
typical value of this parameter is in the range between 

Last 
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Interaction Configurable Parameters Position 

0.7 and 1.    

Also set the yield strength in units of Pa for each particle or 
geometry that has an interaction. EDEM offers a reasonable 
default value for this parameter estimated from material Shear 
Modulus. The user can, however, overwrite this default value. 

Use 

1. Select the required category from the Interaction pulldown in the Physics section 
of the Creator. 

2. Click the + drop-down list then select Hysteretic Spring. 

3. Click the configuration button  to define contact model parameters.  

 

Moving Plane 

The Moving Plane model simulates the in-plane motion of a geometry section when 
contacted by a particle. 

 

Interaction Configurable Parameters Position 

Particle to Geometry Click + to add a section to use as a moving plane. For each 
section, set the X, Y, and Z linear velocity. 

First 

Use 

1. Select Particle-to-Geometry from the Interaction pulldown in the Physics section 
of the Creator. 

2. Be sure a model for contact forces is listed in the Model section. If not, click the + 
drop-down list then select (for example) Hertz-Mindlin (no-slip). 

3. Click the + drop-down list then select Moving Plane. 

4. Click the configuration button  to define the sections to use as moving planes. 
For each section, set the X, Y, and Z linear velocity.  

 

Particle Body Forces 

A particle body force can be set to act on particles when a specified condition is met, for 
example when particles are in certain position or are traveling at a specified velocity. 
Refer to the user section of the DEM website and the EDEM Programming Guide. 
 

Using the Interaction pulldown menu and + pick-list, you can build a list (stack) of 

particle body forces. The top element is applied first, then the next one down and so on. 
Use the up and down buttons to move the force up and down the list. To remove an 

item, click the x button. Click the preferences button to configure the selected force. 
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Configuring  Particle Body Forces 

Name Description and Parameter Values 

Temperature 
Update 

Although not strictly a force, this built-in model allows the modeling of 
model external heat sources acting on the particles. It has to be used 
with the Hertz-Mindlin with Heat Conduction contact model as it also 
completes the calculation of heat transfer between particles in contact 

Set the specific heat capacity for each type of particle. Note the unit 
depends on the temperature unit; for example, the unit will be Jkg

-1
K

-1 

when the temperature unit is Kelvins. 

Use 

1. Select Particle-to-Particle from the Interaction pulldown in the Physics section of 
the Creator. 

2. Click the + drop-down list then select Hertz-Mindlin with Heat Conduction. 

3. Click the configuration button to define the thermal conductivity for each particle 
type. 

4. Select Particle Body Force from the Interaction pulldown. 

5. Click the + drop-down list then select Temperature Update. 

6. Click the configuration button to define the specific heat capacity for each particle 
type. 

 

Gravity 

Enable the gravity checkbox to set gravity in a given direction (x, y, z). The default 
settings are x: 0, y: 0 and z: -9.81m/s2. 
 
 
Materials 
Every particle or section of geometry used in a model is made of a particular material. All 
materials and the interactions between them must be defined in the Materials section. 
Materials can be created directly in the simulation or imported from the Materials 
Database. All materials defined in the Materials section are stored within the model.  

Adding and Removing Materials 

To add a material to a model: 

 Click the + button then type a name for the new material in the Name field. 

 Enter the Poisson's ratio, Shear modulus, Density and Work Function (if 
applicable) into the relevant fields. 

 
You can also click Copy to create a duplicate of the currently selected material. To 
remove a material from a model, select the material from the drop-down list then click 

the x button. 
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Defining Interactions Between Materials 

Interactions are used to define how materials act when they come into contact with each 
other. Interactions must be defined for all materials used in your model, including the 
interaction that occurs when a material comes into contact with itself: For example when 
two particles of the same material collide. 
 

To define an interaction between two materials: 

 Select the first material from the Name drop-down list. 

 Click the + button in the Interactions section.  

 Select the second material from the Select Material dialog. 

 Enter values for the Coefficient of Restitution, Coefficient of Static Friction and 
Coefficient of Rolling Friction into the relevant fields. 

 

The Materials Database  

The EDEM Materials Database is a repository for material and interaction data. It stores 
material data in one central location. The material data can then be imported into 
simulations as desired. 
 

The Materials Database supplied with EDEM contains three example materials. These 
represent materials that have: 
 

 Low-stiffness  (such as rubber) 
 Medium-stiffness (such as plastic) 
 High-stiffness (such as steel) 

 

By default, the Materials Database (MaterialsDB.ddb) is installed to the My Documents > 
EDEM folder. If you move the Materials Database (for example to a shared network 
folder for use by multiple clients), remember to update the location information in EDEM. 
To do this, select Tools > Options > File Locations then browse to the new location. 

Adding Materials and Material Interactions to the Database 

Materials and material interactions can be added to the database directly or transferred 
from an existing simulation.  
 
Note that materials defined in your database are not automatically added to any model. 
All materials used in a model must be defined directly in that model or explicitly 
transferred from the materials database. 

Adding and Removing Materials 

To add a material to the database: 

 Select Tools > Materials Database from the Creator to open the Materials 
Database. 

 Click the + button and type a name for the new material in the Name field. 
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 Enter values for the Poisson's ratio, Shear modulus, Density and Work Function 
(if applicable) into the relevant fields. 

 
To remove a material from the database: 

 Open the Materials Database. 

 Choose the material from the drop-down list and click the x button. The material 

is permanently removed from the database. 
 
Click the Copy button to create a duplicate of the currently selected material. 

Importing Materials from other Databases 

Materials can be imported from other EDEM Material databases.  

 Open the Materials Database. 

 Click the Import button and navigate to the Materials Database (.ddb) of your 
choice. 

 Click Yes to import all materials and interactions. Click No to import a limited 
selection of the database. 

Transferring Materials to and from the Materials Database 

Any material or interaction defined in a model can be transferred to the materials 
database for use in other simulations. Similarly, materials and interactions can be 
imported from the database into your model.  
 
To transfer a material to or from the database: 

 Click the Transfer button. The Transfer dialog box appears. 

 Click on the material to transfer. The material's properties are displayed at the 
bottom of the dialog. 

 Click the appropriate arrow to transfer the material to or from the database. 

Conflicts 

If a material in the model and one in the database have the same name but different 
properties they are highlighted in red to indicate the conflict. If you continue with the 
transfer, one material will overwrite the other. 
 
If two materials have the same name and the same properties they are both highlighted 
in green. 

 

Defining Particles  

All types of particle used in a model are defined in the Particles pane. These are the 
base or prototype particles. A model can contain any number of different particle types. 

Select Particle 
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Creating or Removing Particle 

 To create a particle click the + button and type a name in the Name field. A 

single spherical surface is automatically created. 

 To copy an existing particle, select it from the drop-down list and click the  
button. 

 To remove a particle, select it from the drop-down list and click the x button. 

Importing a Particle 

Any particle created in EDEM can be exported for use in other models. To import a 
particle click the Import button and navigate to your chosen file. 

Using a Particle Template 

Mesh files created in other packages can be used as particle templates. A template can 
be used as a guide to create your particle and its properties automatically calculated 
from it. Refer to Appendix C: EDEM File Types on page 122 for a list of file-types that 
can be imported. We recommend using a template if your model uses multi-sphere 
particles. 
 

To use a template: 

 Go to the Tools > Particle Display menu. 

 Click the Import button and navigate to the file of your choice. Any templates 
used in your model must first be imported here. 

 Select the Show Template option in the Viewer controls pane at the right of the 
screen and choose your template from the drop-down list. 

 Create surfaces to match the template outline. 
 
When a model containing a particle template is saved, an extra file (.ptf) is created 
alongside the usual three files (.dem, .dfg and .idx). If this file is deleted, the template 
information will no longer be stored within the model. 

 

Surfaces 

A particle is defined using one or more spherical surfaces. Multiple surfaces can be 
overlapped to create multi-sphere particles. 

 Click the + button then type a name for the surface in the Name field. 

 Type the surface Radius. 

 Select Contact Radius when the particle has a different contact radius due to 
another (long-range) force acting upon it. This option should only be used with a 
relevant user-defined contact model. When two contact radii overlap the contact 
force calculation is entered into, however internally the physical radius of the 
spheres is used to calculate the magnitude of the contact force.  

 For multiple surfaces, use the Position X, Y and Z options to define their relative 
positions. Note that multi-sphere particles should be centered on the origin along 
the principle axes to ensure that the moments of inertia are calculated correctly. 
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Properties 

Particle properties refer to the whole particle, not just to individual surfaces. Particle 
properties can be inserted manually or calculated automatically. 

Automatically 

 Click Calculate Properties then select whether to calculate using the spherical 
surfaces that make up your particle, or (preferably) from an imported template.  

 Check whether you want to automatically center the particle when calculating the 
moments of inertia. Unchecking this option may result in unphysical results. 

 Click OK. EDEM calculates the mass, volume, and moments of inertia. 

Since random sampling is used to calculate particle properties, re-calculating for 
particles with multiple surfaces may result in slightly different values. 

Manually 

Type values for each property into the relevant field. If a value turns red it is not 
recommended. 
 

Property Description 

Material Choose a particle material. The drop-down list is populated with any 
material defined in the Globals pane 

Mass Mass of the particle. 

Volume Volume of the particle measured. 

Moment of 
Inertia X/Y/Z 

The moment of inertia is a measure of a body's resistance to angular 

acceleration. A particle consists of a number of spheres, i,  each with 

mass mi and radius ri. If each sphere is a distance di from a 

particular axis of rotation, then the moment of inertia of the particle 
about that axis is given by:  

 

Particle Limits 

Under certain simulation conditions the velocity of a particle can become too large and 
cause surrounding particles to behave erratically: For example, when the simulation time 
step is too large. There are two ways to help combat this. Particle velocities can be 
capped at a specified limit or particles exceeding that limit can be removed from the 
simulation. Particle velocity and angular velocity can be treated separately. 

Particle Export 

Once a particle has been defined it can be exported for use in other EDEM simulations. 
Click the Export button and save the file to your Particles folder (as specified using Tools 
> Options > File Locations). Files are exported in the .dem format. 
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The Model Domain 

The model domain is the area where simulation takes place. It is defined in the 
Geometry tab and indicated by the red box in the Viewer: 
 

 
 
Particles that move out of the domain during the course of the simulation are 
permanently removed by the Simulator (unless a periodic boundary option has been 
selected). Geometry can move in and out of the domain during a simulation. 

 

Defining the Model Domain 

Domain size has an effect on simulation time - the larger the domain, the longer the 
simulation will take to run. Use the auto-update option to automatically fit the domain 
around any sections of geometry defined, thus creating the smallest domain possible. 
 

Note: Sections of geometry should not be placed totally coincident with the edge of the 
domain. Particles are removed as soon as they reach the domain edge, so cannot 
interact with any geometry placed there.  

Periodic Boundaries 

Periodic boundaries enable you to set what happens to a particle once it leaves the 
domain. If the option is turned on for a particular direction, any particle leaving the 
domain in that direction will instantly re-enter it on the opposite side. 
 
 

Creating Geometry Sections 

Geometry sections are used to create the environment in which your particles act: For 
example, a pipe or a mixing drum. Sections can be defined in EDEM or imported from a 
CAD (or similar) package. Particle factories are also created using sections.  
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A model can have any number of sections allowing complex machinery to be created. A 
section can be defined as a box, a cylinder or as an n-sided polygon. Each section 
comprises a number of triangular elements: For example a square surface is made up of 
two elements and a ten-sided polygon of ten elements. Information on these elements 
can be examined at a later point: For example, contacts with a particular element. The 
individual elements can be seen by choosing the mesh display mode. 

Create a New Geometry Section 

To create a new section: 

1. Go to the Geometry tab. 

2. Click the + button then choose the shape. Select box, cylinder or polygon. 

3. Type a name for the section in the Name field. 
 
The section should now appear in the Viewer. Note the default size of some sections is 
quite small and may not be immediately visible in your domain. 
 
Set the basic properties in the Details tab: 
 

Property Description 

Volume A section is described as a volume or a surface. Completely closed 
boxes and cylinders are volumes; polygons and open boxes or cylinders 
are surfaces. This field is completed automatically. 
Volumes or virtual surfaces can later be turned into particle factories. 

Material Select a section material from the drop-down list. The materials listed are 
defined using the Materials Section in the Globals pane. 

Type A section is either virtual or physical. A physical section is an actual 
surface or volume that particles can interact with. A virtual section (used 
to create particle factories) is a surface or volume of interest that does 
not actually exist and does not interact with anything in a simulation. 

Center of 
Mass 

For every closed-volume geometry (such as a box or closed cylinder), 
EDEM automatically calculates the center of mass when you first import 
or create the geometry. If required, set the center of mass parameters for 
X, Y, and Z components (for imported geometries) or click the auto-
adjust checkbox for geometry sections defined in EDEM. 

 

Specify the Section Properties 

Once a section has been created a third tab (Box, Cylinder or Surface) will appear. Click 
on the tab and define size, shape and position of your section. Note geometry sections 
outside of or directly coincident with the domain boundary do not take part in the 
simulation, and will hence be 'invisible' to particles.  
 

Section Parameters 

Box 
 Center. Set the position of the center of the box. 

 Dimensions. Set the box height, width and length.  

 Rotation. Set the box rotation about the x, y or z axes. 
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 Enable Sides. Any of the six sides of the box can be removed. 

Cylinder 
 Radius Start. Set the radius of one end of the cylinder. The end can 

be open or closed. 

 Radius End. Sets the radius of one end of the cylinder. The end can 
be open or closed. 

 Start Point (x), End Point (x). Set the x-position of each end of the 
cylinder. 

 Start Point (y), End Point (y). Set the x-position of each end of the 
cylinder. 

 Start Point (z), End Point (z). Set the x-position of each end of the 
cylinder. 

Polygon All polygons except a 4-sided polygon are defined as follows: 

 Edges. Set the number of edges. The minimum number is three. 

 Center. Set the position of the center of the polygon. 

 Rotation. Set the angle of rotation about the surface normal.  

 Surface normal. Define the surface normal to determine the 
orientation of the polygon. 

A 4-sided polygon is specified as follows: 

 Edges. Set the number of edges to four. 

 Center. Set the position of the center of the polygon. 

 Dimensions. Set the length and the width. 

 Rotation. Set the angle of rotation about the x, y or z axes. 
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Example Geometry Sections 

Box Section Examples 

  

A closed cube 
 

  
Center 
(m) 

Dimensions 
(m) 

Rotation 
(rad) 

X 0.5 0.2 0 

Y 0.5 0.2 0 

Z 0.5 0.2 0 
 

An open, tilted cuboid. 
 

  
Center 
(m) 

Dimensions 
(m) 

Rotation 
(rad) 

X 0.5 0.5 -0.5 

Y 0.5 0.2 0 

Z 0.5 0.1 0 
 

 

Cylinder Section Examples 

  

A vertical cylinder 
 

Radius Start: 0.1     

Radius End: 0.1     

        

Start Point (x): 0.5 End Point (x): 0.5 

Start Point (y): 0.5 End Point (y): 0.5 

Start Point (z): 0.2 End Point (z): 0.8 
 

A cylinder tilted in the y-direction  
 

Radius Start: 0.1     

Radius End: 0.1     

        

Start Point (x): 0.5 End Point (x): 0.5 

Start Point (y): 0.5 End Point (y): 1.0 

Start Point (z): 0.2 End Point (z): 0.8 
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Cylinder Section Examples (Continued) 

  

A cylinder tilted in the x-direction  
 

Radius Start: 0.1     

Radius End: 0.1     

        

Start Point (x): 0.5 End Point (x): 1.0 

Start Point (y): 0.5 End Point (y): 0.5 

Start Point (z): 0.2 End Point (z): 0.8 
 

A funnel tilted in the x-direction  
 

Radius Start: 0.1     

Radius End: 0.3     

        

Start Point (x): 0.5 End Point (x): 1.0 

Start Point (y): 0.5 End Point (y): 0.5 

Start Point (z): 0.2 End Point (z): 0.8 
 

 

Polygon Section Examples 

   

A 6-sided polygon.  

  
Center 
(m) 

Surface 
normal 

X 0.5 0 

Y 0.5 0 

Z 0.5 1 

Radius = 0.4m, Rotation = 0 rad 

An 4-sided, tilted polygon.  

  
Center 
(m) 

Rotation 
(rad) 

X 0.5 0 

Y 0.5 0 

Z 0.5 0.5 

 Side 1 = 0.5m, Side 2 = 0.3m 

An 3-sided, tilted polygon. 

  
Center 
(m) 

Surface 
normal 

X 0.5 0 

Y 0.5 0.5 

Z 0.5 1 

 Radius = 0.3m, Rotation = 0 rad 

 
 

Specify the Section Dynamics 

Sections of geometry can be static or dynamic. Static sections remain in a fixed position 
during the course of a simulation whereas static sections move. Sections can move 
under translation or rotation. 

Sections are strain limited, they will not move when a force provided by another element 
is applied. For example, a section will not move when another section comes into 
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contact with it or when a particle bounces off it. Sections pass through each other when 
they come into contact. 
 
Specifying a Translation 

 Select the section from the Sections drop-down list. 

 Go to the Dynamics tab. 

 Click the + button then type a name for the dynamic in the Name field. 

 Set the dynamic type to Linear or Sinusoidal Translation (used to model 
oscillating motion). 

 

Translation Set-up 

Linear 
 Set the Start time and End time. This determines the points 

in the simulation at which the motion will begin and end. 

 Set the Initial velocity of the section. This determines the 
speed of the section at the specified start time. 

 Specify the Acceleration of the section. Acceleration can be 
set to 0. 

 Set the direction vector for the motion. This determines the 
direction the section will move in. 

Sinusoidal 
 Set the Start time and End time. This determines the points 

in the simulation at which the motion will begin and end. 

 Set the distance (also known as the amplitude) of the 
oscillation in each direction.   

 Specify the frequency of the oscillation. 

 Specify the oscillation offset: For example, two sections 
with identical oscillations offset by 180° will travel in 
opposite directions. 

 
 
Specifying a Rotation 

 Select the section from the Sections drop-down list. 

 Go to the Dynamics tab. 

 Click the + button then type a name for the dynamic in the Name field. 

 Set the dynamic type to Linear or Sinusoidal Rotation (used to model oscillating 
motion). 

 

Rotation Set-up 

Linear 
 Set the Start time and End time. This determines the points 

in the simulation at which the rotation will begin and end. 

 Set the Initial velocity of the section. This determines how 
fast the section will start rotating at the specified start time. 
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 Specify the Acceleration of the section. Acceleration can be 
set to 0. 

 Set the axis of rotation. This defines around which axis the 
section will rotate. 

 Specify the point of action (the center of the rotation). If the 
geometry section is also moving under a translation, select 
the Moves With Body option to update center as the section 
moves. This will ensure that the center of the rotation 
remains in the same relative position to the geometry 
section. 

Sinusoidal 
 Set the Start time and End time. This determines the points 

in the simulation at which the motion will begin and end. 

 Set the angle of the oscillation in each direction.   

 Specify the frequency of the oscillation. 

 Specify the oscillation offset. 

 Specify the center of the rotation. If the geometry section is 
also moving under a translation, select the Moves with body 
option to update center as the section moves. This will 
ensure that the center of the rotation remains in the same 
relative position to the geometry section. 

Turning a Section into a Particle Factory 

Particle factories are used to define where, when and how particles appear in a 
simulation. Any virtual surface or volume (physical or virtual) can be turned into a particle 
factory. See Particle Factories on page 40 for more details. 

 

Importing Geometry Sections  

Rather than defining sections using EDEM, geometry can be imported from a range of 
other packages. Refer to Appendix C: EDEM File Types for details. 

1. Click the Import button in the Sections area of the Geometry tab. 

2. Navigate to the file to import then click Open. If applicable, the Geometry Import 
Parameters dialog is displayed. 

a) Choose to import as a quality or curvature mesh.  

 A quality mesh is usually made up of equilateral facets. It often 
contains more facets compared with a curvature mesh. 

 A curvature mesh usually matches the contours of a body well, but is 
often made of non-equilateral facets. 

b) Set the facet options, depending on the method you selected. Set facet 
sag and facet length to a percentage of the model diameter, or use the 
default values. Click OK. 
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3. The Import Options dialog is displayed. 

a) Select the unit of measurement the geometry is measured in.  

b) Tick the Merge Sections checkbox to merge separate geometry sections 
into one single section. 

4. Click OK. You may need to wait some time for the geometry import to complete, 
especially when you did not select default values in the previous step. 
Once imported, the geometry is displayed in the Viewer. Each section is listed in 
the section drop-down list. 

5. Complete the Details options. See Create a New Geometry Section on page 33. 

6. Set the Dynamics (if required). See  

7. Specify the Section Dynamics on page 36. 

 
Repositioning Imported Geometry Sections 

Imported CAD geometry sections can be moved (translated) and rotated. You can also 
export the translation data to a text file. 

 Select the imported section from the Sections drop-down list. 

 Go to the Geometry tab then define the transformation as required. 

 Tick the Display Bounding Box checkbox to display a blue box around the 
geometry section, aligned to its axis. 

 

Movement Parameters 

Translation Set the position of a translation vector to determine where to move the 
geometry to. The direction of the translation is the vector defined by the 
start and end points. Once set, specify the distance to move the 
geometry along the vector. 

 Pick Start Point. Click to enable the target crosshair, then click a 
point on a geometry in the Viewer to set the start point for the 
translation. 

 Pick End Point. Click to enable the target crosshair then click a 
point on a geometry in the Viewer to set the end point for the 
translation. 

 Start Point X, Y, Z. Specify the X, Y, and Z coordinates of the 
start point of the vector along which the geometry is to be 
translated. 

 End Point X, Y, Z. Specify the X, Y, and Z coordinates of the 
end point of the vector along which the geometry is to be 
translated. 

 Distance. Specify the distance to move the geometry along the 
vector.  

 Display Vector. Click to view the translation vector. 

Rotation Set the position of a rotation axis to determine how to rotate the 
geometry. This axis is specified as a vector between two points around 
which all rotations are performed using a rotation angle. Once set, 
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specify the angle to rotate the geometry around the axis. 

 Pick Start Point. Click to enable the target crosshair, then click a 
point on a geometry in the Viewer to set the start point for the 
rotation. 

 Pick End Point. Click to enable the target crosshair then click a 
point on a geometry in the Viewer to set the end point for the 
rotation. 

 Start Point X, Y, Z. Specify the X, Y, and Z coordinates of the 
start point of the vector along which the geometry is to be 
rotated. 

 End Point X, Y, Z. Specify the X, Y, and Z coordinates of the 
end point of the vector along which the geometry is to be 
rotated. 

 Angle. Specify the angle to rotate the geometry around the 
vector.  

 Display Axis. Click to view the rotation axis. 

 
To export the transformation settings, select File > Export > Geometry Transformations. 
Choose which sections to export data from then specify a file. Click the export button to 
save the transformation data to a text file. 

Merging Geometry Sections 

Geometry sections can be merged at any time. 

1. Select the section to merge into. The merged sections inherit this section name. 

2. Click the Merge button in the Sections area of the Geometry tab. 

3. Select the geometry sections to merge then click OK. 

 

Copying Geometry Sections 

Created and imported geometry sections can be copied.  

1. Select the geometry section you want to copy. 

2. Click the Copy  button. 

A copied geometry appears in the same position as the original; it is not offset 
from the original’s position. The name of the new section has a copy number at 
the end of the name of the original section. 

 

Particle Factories 

Creating Particle Factories  
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Particle factories are used to define where, when and how particles appear in a 
simulation. Any virtual surface or volume (physical or virtual) can be turned into a particle 
factory. Particles, based on the prototype particles previously defined, are then created 
on or in the specified section. A model can have any number of particle factories.  
 

Click on the + button to create a new factory. Click the copy button to create a copy of 
the currently selected factory. Click the Import button to import your own custom particle 
factory (for details on custom particle factories, refer to the EDEM Programming Guide). 
 

There are two types of particle factory: static and dynamic. 

Static Factories 

Static factories produce particles at a specified time. Simulation is paused during particle 
creation.  
 

Parameter Details 

Number or mass 
of particles 

For a static factory, select either: 

 Fill Section. Creates as many particles as will fit on or in 
the chosen geometry section. 

 Total Number. Produce a specified number of particles. 

 Total Mass. Produce a specified amount of mass. 

Start time Set the time at which particle creation will take place. 

Max attempts to 
place particle 

If you select random particle position, you must also define the 
maximum number of attempts to place a particle. 

During simulation, EDEM attempts to place particles in a random 
position in or on the specified section. If placing the particle in 
that position would cause an overlap with any other physical 
element in the model, the simulator will abandon the position and 
try to find another. It will attempt this for the specified number of 
times for each particle. 

 
Dynamic Factories 

Dynamic factories produce particles over the duration of a simulation. Simulation 
continues as the particles are created. 
 

Parameter Details 

Number or mass 
of particles 

For a dynamic factory, select either: 

 Unlimited Number. This creates as many particles as will 
fit on or in the chosen geometry section. If selected, the 
factory will attempt to create particles continuously from 
the specified start time until the end of the simulation. 
Particles will continue to be created even after a section 
surface or volume is full. This may cause the rest of the 
simulation to slow down. 

 Total Number. Produce a specified number of particles. 
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 Total Mass. Produce a specified amount of mass. 

Generation rate  Target Number. Define the number of particles the 
simulator will attempt to place in or on the section every 
second. 

 Target Mass. Define the mass generation rate the 
simulator should aim to create. When simulation starts, 
this rate is converted into mass per-timestep. If this is less 
than the smallest particle mass, the factory does not 
create a particle but adds the mass to the mass for the 
next timestep. Once there’s enough mass, the factory 
creates a particle. If the mass per-timestep is greater than 
the smallest particle mass, the factory places particles 
until it reaches the mass per timestep. Be sure your 
factory is large enough to create the required mass rate: if 
not, a warning message may be displayed prompting you 
to update the rate. 

Start time Set the time particle creation starts. 

Max attempts to 
place particle 

During simulation, EDEM attempts to place particles in a random 
position in or on the specified section. If placing the particle in 
that position would cause an overlap with any other physical 
element in the model, the simulator will abandon the position and 
try to find another. It will attempt this for the specified number of 
times for each particle. 

Initial Conditions 

The initial conditions area is used to specify the section to use as a factory, and 
to define the starting conditions of the particles it creates.  
 

Parameter Options 

Section Select the section that will become a particle factory. Only suitable 
sections are listed. Any virtual surface or volume (physical or virtual) 
can be turned into a factory.  

Type A factory can produce one or two different types of particle. Particle 
types must first be defined in the Particles pane. The options are: 

 Fixed. One fixed particle type. 

 Binary. Two types of particle can be used. This option is useful 
when creating binary lattices. 

Size The standard size of any particle type is defined in the Particles pane. 
Factories can also produce particles with a distribution of sizes based 
upon this standard size. All sizes are defined as factors of the 
originally specified size. The options are: 

 Fixed. All particles are of an equal size: For example, if the size 
ratio is set to two, all particles will be twice the standard radius. 

 Random. Particle radii are randomly sized within a set size 
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Parameter Options 

range: For example, with a minimum size of 0.5 and a 
maximum of 1.5, particles no smaller than half and no bigger 
than one-and-a-half times the size of the standard size are 
produced. 

 Normal distribution. Particle radii have a normal distribution. 
The average (mean) particle radius or volume and the standard 
deviation must be defined. The mean and standard deviation 
should both be normalized i.e. the mean is the ratio of the 
mean to the input particle radius or volume and similarly for the 
standard deviation. Use the capping options to cap the 
maximum and minimum particle sizes. 

 Log-normal distribution. Particle radii have a log-normal 
distribution. The average (mean) particle radius or volume and 
the standard deviation must be defined. The mean and 
standard deviation can be defined using a logarithmic or linear 
scale. With a logarithmic scale, the input values are 
exponential functions. For example, a mean value of 1 in the 
logarithmic scale denotes an actual scaling of 2.718 in the 
linear scale. Note that the mean and standard deviation should 
both be normalized i.e. the mean is the ratio of the mean to the 
input particle radius or volume and similarly for the standard 
deviation. 

Note that changing the size of particles in this way does not affect 
Rayleigh timestep calculations. Setting a greatly reduced particle size 
may require a smaller timestep. 

Position When particles are created, they are placed on or in the specified 
section. Particles are never created on top of one another. When a 
factory tries to create a particle it will repeatedly attempt to find free 
space to place it. 

The position of the particles can be: 

 Random. Particles are positioned randomly or through a 
random walk. With a random walk, particles are placed one 
after another along a path in discrete steps of a defined length. 
This length is a factor of the maximum extent of the particle. 
The maximum angle that can be turned at each step is also 
defined. 

 Cubic. Particles are created in a simple cubic lattice. Select the 
Display Lattice option in the Viewer controls pane to show the 
lattice in the Viewer. 

 BCC lattice. Particles are created in a body-centered cubic 
lattice. It is defined in the same way as a cubic lattice. 

 FCC lattice. Particles are created in a face-centered cubic 
lattice.  It is defined in the same way as a cubic lattice. 

Note only a random position is selectable when defining a total mass 
to create. 

Velocity Particles can be given a velocity at the time of creation. Options are: 
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Parameter Options 

 Fixed. All particles have the same fixed velocity. The velocity 
must be defined as a vector. 

 Random. Each particle is given a velocity at random within a 
defined range. 

 Normal distribution. The particle velocities have a normal 
distribution. The particle direction, mean velocity and the 
standard deviation must be defined. 

 Linear distribution. The particles are given velocities that fall on 
the line segment between the two velocity vectors provided by 
the user.  

 

 Spray. The particles are formed in a conical spray. The spray 
direction is defined as a velocity vector. The angle is the angle 
of maximum deviation from the normal. The mean velocity and 
standard deviation must also be defined. 

 

Orientation Particles can be given an orientation at the time of creation. This is 
useful for non-spherical particles. The options are as follows: 

 Fixed. All particles have the same fixed orientation. The 
orientation is defined in an orientation matrix. EDEM 
automatically adjusts the values you enter to maintain an 
orthogonal orientation matrix. 

 Random. Each particle is given a random orientation. 

Angular 
velocity 

Particles can be given an angular velocity at the time of creation i.e. 
they will be spinning when placed on or in the specified section. The 
options are as follows: 

 Fixed. All particles have the same fixed angular velocity. The 
velocity must be defined as a vector. 

 Random. Each particle is given an angular velocity at random 
within a defined range. 

 Normal distribution. The particle angular velocities have a 
normal distribution. The particle direction, average angular 
velocity and the standard deviation must be defined. 

 Linear distribution. Particles are given angular velocities that 

V1 

V2 
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Parameter Options 

fall on an arbitrary arc drawn between two velocity vectors. 

Custom 
Property 

If you have defined any custom properties, particles can be given a 
custom property value at the time of creation. Options are: 

 Fixed. All particles have the same fixed value. 

 Initial. Particles use the initial value of the property. 

 Normal. Custom property values have a normal distribution. 
The mean and standard deviation must be defined. 

 Random. Each particle is given a value at random within a 
defined range. 

 
Table 2-1: Table of particle parameters 
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EDEM Simulator 

About the EDEM Simulator  

The EDEM Simulator is the discrete element solver used to carry out your simulation. 
Select the contact model and watch as your model is processed. 
 

 
 

 Simulator Pane 

 Viewer 

 Viewer Controls 

 Solve Report 

 Toolbar and Menu Bar 

 

Simulator Pane 

The Simulator Pane is where you set the time step, simulation time, and grid options. 
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Viewer 

The Viewer displays 3D representations of your particles, geometry, and fields (if 
applicable). The rotation, position and zoom factor of the Viewer are controlled using the 
mouse. The simulation start/stop button and simulation progress bar are just below the 
viewer (see Starting and Stopping a Simulation on page 54 for more details). 

Viewer Controls (Simulator)  

The Viewer Controls are used to determine how items are displayed in the Viewer.  
 

 Current time. The current simulation time is displayed. Simulation can be stopped 
and any previous full time step viewed. Simulation can be restarted from any 
previous full time step. 

 General 

 Show simulator grid. Enable or disable the display of the simulator grid 
cells. 

 Auto update. If selected, the Viewer updates for every iteration. Simulation 
will be slower, however the slow down can be minimized by lowering the 
particle detail. 

 Refresh Viewer. When the auto update option is disabled, click to refresh 
the Viewer display. 

 View. Controls to change, add, and configure camera views. See Viewer Controls 
(Creator) on page 16. 

 Geometry 

 Display mode. Configure the display of all the geometry in the Viewer. 
Choose between filled, mesh or points style display. 

 Opacity. Set the opacity level of the geometry in the Viewer. 

 Show particles. Display particles. 

 Fields 

 Display field. Select a field from the pick-list then tick to enable or disable 
display of the field in the viewer. Vector fields are displayed as arrows; 
scalar fields are displayed as points. 

 Color. Select a color to display the field as. The default is Blue. 

 Scale. Set the length of the field’s vector line. 
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Solve Report (Simulator)  

The Solve Report is an .html page that displays detailed information about your model. 
Right click anywhere within the Solve Report and choose Save to save the information in 
an .html file. There are six sections in the Simulator’s Solve Report: 

Simulation 

 status. Whether the simulation is processing or stopped. 

 current time. Time into processing. 

 time step. The time step used by the model as detailed in the Simulator. 

 estimated total computation time. The estimated total time to complete the 
simulation. 

 elapsed computation time. Time since the simulation started (excluding pauses). 

Grid cells 

 status. Either allocating grid cells or grid cells have been initialized. 

 total number. The total number of grid cells in the model. 

 side length. The dimensions of grid cells as specified in the Simulator. 

 created. The number of grid cells created. 

Particles 

 total number. The total number of particles in the model. 

 total removed. The total number of particles removed from the model: For 
example, particles that move beyond the domain boundaries. 

 minimum speed. The speed of the slowest particle in the model. 

 maximum speed. The speed of the fastest particle in the model. 

Geometry Section 

 speed. The speed of the geometry section. 

 number of particles in contact. The total number of particles in contact with the 
geometry section at the current time step. 

Energy 

 system energy. The total energy in the model at the current time. It is the sum of 
the kinetic energy, potential energy and the energy in any contacts taking place. It 
should be equal to the total energy gained by creating particles plus the total energy 
gained by geometry movement minus the energy lost through contacts minus the 
energy lost by removing particles. 

 kinetic & potential energy. The total kinetic and potential energy in the system. 

 total lost by removing particles. Total energy lost by removing particles from the 
domain. 

 total lost through contacts. Total energy lost by contacts between elements. 

 total gained by creating particles. Total energy gained. 

 total gained by geometry movement. The total energy gained through the 
movement of sections of geometry. 
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Factory 

 status. The current factory status. 

 total particles created. Number of particles accepted and currently being generated. 

 total particles regenerated. Number of particle creation attempts. 

 total particles failed. Number of particles that could not be placed once the Max 
attempts to place particle is reached. 

 total particles accepted. Number of particles accepted in the grid. 

 creation rate/target creation rate. The particle or mass creation rate as specified 
in the Factories pane. 

 mass created since rate change. Amount of mass created by the factory (when 
creation rate is set to target mass rate of particles) 

 actual creation rate since rate change. The actual creation rate (as opposed to 
the target creation rate) when creation rate is set to target mass rate of particles. 

Simulator Toolbar  

Icon Name Description 

 Creator Switch to the Creator 

 Simulator Switch to the Simulator 

 Analyst Switch to the Analyst 

 New Start a new model 

 Open Open an existing model 

 Save Save any changes made to Simulator settings 

 Help View the online help 

Simulator Menu Bar  

File Menu 

 Save. Save any changes made to Simulator settings. 

 Creator. Select to switch to the Creator. 

 Simulator. Select to switch to the Simulator. 

 Analyst. Select to switch to the Analyst. 

 Quit. Quit EDEM. 

Tools Menu 

The Tools Menu in the Simulator is the same as for the Creator. See the Creator Tools 
menu on page 19 for details. 
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Simulator Settings 

Time Steps 

The time step is the amount of time between iterations (calculations) in the Simulator. The 
time step is fixed and remains constant throughout the simulation. The value is displayed 
as both the actual time step (in seconds) and as a percentage of the Rayleigh time step. 
The Rayleigh time step is the time taken for a shear wave to propagate through a solid 
particle. When using a simulation with a range of particle sizes, the Raleigh time step is 
calculated based on the smallest particle size. Refer to Appendix A: Estimating Simulation 
Time for more information. 

 
The smaller the time step, the more data points are produced. A large number of data 
points produce results with a very fine level of detail, however the simulation time will be 
longer due to the increased number of calculations required. 

Choosing a Time Step 

If the time step is too small, the simulation will take a long time to run. If the time step is too 
large, particles can behave erratically. For example, the figure below shows two particles 
moving towards each other. At time step 1 they are some distance apart. The particles are 
moving towards each other at some speed, and when their positions are recalculated at 
time step 2 they are apparently over-lapping. The particle forces and energies are 
recalculated at this point, however these values are very large due to the apparent overlap; 
this supplies each particle with a very large and incorrect velocity, and they move off 
erratically at time step 3. Subsequently, these particles can come into contact with other 
elements in the system, often causing an 'explosion' of incorrectly moving elements. To 
recover from such an event, set particle limits using the Creator’s Particles tab. 
 

 
Time step 1 Time step 2 Time step 3 

Simulation Time 

The simulation time is the amount of real time your simulation represents.  

 Total Time: The total actual length of the simulation in seconds or minutes. 

 Required Iterations: Indicates the number of iterations required to complete a 
simulation of a defined time using the defined time step. For example, 5e+05 
iterations are required to produce one second of simulation with a time step of 2e-06. 
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Data Save 

 Target Save Interval: How often data should be written out to a file. This 
determines the number of data points (the points at which data is collected from the 
simulation for analysis). 

 Synchronized Data Save: The actual time that data will be saved. This is usually the 
same as the target save interval,  but may differ depending on the timestep time. 

 Data Points: The number of data points as determined by the target save interval, It 
is calculated as the total run time divided by the target save interval. 

 Iterations per Data Point: The number of simulator iterations for each data point. 

Selective Saves 

When simulating, EDEM saves particle, geometry, and interaction data for post-processing 
and analysis. Often you may only be interested in a subset of this data: EDEM’s selective 
save feature lets you select which attributes are saved and how often by defining partial 
saves. Using selective save can greatly reduce simulation data file sizes as well as 
enabling you to run even larger simulations. 

Selective save works by combining full saves (where all data is written out) and partial 
saves (where only selected data is written out) to create smaller data sets. For example, 
assume you have a simulation with a total time of 10 seconds that writes-out every 1 
second. By default, this creates a full save of all simulation data every second: 

0 s 1 s 2 s 3 s 4 s 5 s 6 s 7 s 8 s 9 s 

Full Full Full Full Full Full Full Full Full Full 

Setting the Full Data Save Every option to e.g. 3 intervals results in a full save only every 3 
seconds (the first write-out is always a full save): 

0 s 1 s 2 s 3 s 4 s 5 s 6 s 7 s 8 s 9 s 

Full Partial Partial Full Partial Partial Full Partial Partial Full 

To enable selective save: 

1. Tick the Selective Save checkbox. 

2. Enter a value into Full Data Save Every to set the frequency of full data saves. For 
example, set this to create a full save every 5 intervals. 

3. Click the Configure Save button. The Data Save Configuration window is displayed. 

4. Select which particle, geometry, and interaction attribute data to save in a partial save. 
Double-click an attribute to include it in the save. Any other required attributes will also 
be enabled. Untick a data group to exclude related attributes. 

The Data Save Configuration window also displays an estimate of the per-particle or 
per-triangle reduction in data size for each timestep.  

Note that if you stop the simulation early then switch to the analyst, the current timestep will 
be a full save irrespective of the full save interval. 
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Particle Data 

Data Group Attribute Data 

Base Particle Data ID 

 Position 

 Orientation 

 Number of Particles 

 Volume 

 Voidage 

 Mass 

 Moment of Inertia 

 Potential Energy 

Velocity Velocity 

 Kinetic Energy 

Angular Velocity Angular Velocity 

 Rotational Kinetic Energy 

 Total Energy 

Force and Torque Compressive Force 

Total Force 

Torque 

Custom Properties Custom Property 

 

Geometry Data 

Data Group Attribute Data 

Base Geometry Data ID 

 Position 

 Surface Normal 

 Node 

 Number of Geometry Elements 

 Velocity 

 Angular Velocity 

Force and Torque Compressive Force 

Total Force 

Torque 

Custom Properties Custom Property 
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Interaction Data 

Data Group Attribute Data 

Contacts (Particle-Particle) All particle-particle contact attribute data 

Contacts (Particle-Geometry) All particle-geometry contact attribute data 

Collisions (Particle-Particle) All particle-particle collision attribute data 

Collisions (Particle- Geometry) All particle-geometry collision attribute data 

Bonds All bond element attribute data 

Custom Properties All interaction-based custom property data 

 
 

Simulator Grid 

Select the Show Simulator Grid option to display the grid in the Viewer. 
 
The main computational challenge in DEM simulation is the detection of contacts. By 
dividing the domain into grid cells, the simulator can check each cell and analyze only 
those that contain two or more elements (and therefore a possible contact), thus reducing 
processing time. The results achieved by a simulation are not affected by the number of 
grid cells, only the time taken to reach them. The simulation process is: 
 

1. Draw the grid, dividing the domain into cells of a specified size. 
2. Identify active cells (those containing two or more elements) and check for contacts. 
3. Calculate forces on elements. 
4. Reposition elements as a result of any force acting upon them. 
5. Active cells are again identified and the process repeats. 

 

As the grid length decreases, fewer elements are assigned to each grid cell and contacts 
become easier to resolve. The fewer particles per grid cell, the more efficient the simulator. 
If there is no more than one particle in each grid cell then no contact detection needs to 
take place so the simulation will progress faster. The idealized length of a grid cell is 2Rmin 
where Rmin is the minimum particle radius in the simulation. If this results in more memory 
allocation than available, reduce the number of grid cells to avoid the time-consuming 
swapping of memory to the hard disk. 

Collision Detection 

EDEM uses the grid to detect collisions. The domain is split into grid cells whose 
dimensions are approximately that of the particle diameter. Each particle and geometry 
element is then assigned to one or more grid cell based on its position. Once this is 
complete for all particles and elements, each grid cell is investigated to see whether it 
contains more than one object. Any grid cell containing more than one object is analyzed 
further to check for objects in contact with each other. To do this, EDEM compares the 
distance between the center of the spheres and the known radii of the spheres. 

Storing Collision Data 

During a simulation data can be recorded about both contacts and collisions. 

 Contacts are the impacts occurring between elements at data write-out points. In 
other words, the contact is in progress when the write-out takes place. The contact 
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has an associated force, position and so on - these are discrete values. If two 
elements stay in contact with each other for some time e.g. over 4 write-out points, 
four contacts will be stored and each of these may have a different force, position 
and so on. 

 Collisions are complete impacts.  When two elements collide it will register as one 
collision, regardless of how long the elements stay in contact for.  Data is collected 
for the duration of the collision e.g.  total energy loss, min/max/average normal 
force data and so on. Collisions may occur in-between write-outs and never register 
as contacts. 

EDEM records all contact data as standard. To record collision data, enable Track 
Collisions. Storing collision data will significantly increase memory usage. Collision data is 
stored in memory until it is written out at the rate specified in the Simulator. If a large 
number of collisions are occurring and the write out frequency is too low, the amount of 
data being stored in memory will become very large and use up all memory resources. To 
minimize this, be sure data is written out frequently. 

Processors 

The number of processors available to the Simulator depends on: 

 The number of physical processor cores in your system 

 The number of processor keys you have purchased 

Select the required number of processors from the Number of Processors pulldown. When 
you start a simulation, EDEM reserves the requested number of keys from the license pool 
(if available). If your BIOS has hyper-threading enabled, EDEM may report the number of 
processors incorrectly. Be sure to consider the number of physical cores in your system. 

Starting and Stopping a Simulation 

The start/stop button is used to start and stop the simulation: 
 

 
 

 
 
The current simulation time is shown in the top left corner of the Viewer Controls pane. All 
previous time steps are also listed. You can stop and start the simulation from any time 
step (current or previous) using the start/stop button. Simulation can also be stopped using 
the keyboard shortcut Ctrl + Shift + K. 

Starting a simulation reserves processor keys from the license pool. If there are not enough 
keys currently available, EDEM prompts you to decide whether to stop or continue with 
fewer processors (depending on how many processor keys are available). 

Stopping a simulation saves simulation data (this may take a while, depending on the size 
of the simulation) and returns reserved processor keys to the pool of total keys available to 
all users. 
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Reducing Simulation Time  

The following can help to reduce processing time. 

 Close the Data Browser. 

 Turn off the auto-update option. If this option is selected, processing time can still 
be reduced by lowering the particle detail. 

 Reduce the simulator grid size. 

 Use partial saves to write-out less data to the simulation file(s). 

Simulation Parameters 

The time taken by the software to perform a single iteration, titeration, is affected quite 

significantly by the simulation parameters. An obvious parameter is the number of 
elements (particle surfaces and geometry elements) to be simulated. EDEM has a near-
linear dependence on the number of elements up to 20,000 (at which point memory 
considerations can affect the simulation speed).  
 

Contact detection is the most significant overhead to an EDEM simulation and extra 
parameters such as geometry dynamics and contact models typically have a secondary 
effect. However, it is worth noting that Particle Factories use contact detection to place 
their particles so a high number of factories, or factories within regions of space with 
medium to high particle volume fractions will significantly affect the simulation speed. 

The Data Browser 

The data browser (solve report) at the bottom of the EDEM window is constantly updated 
with particle details. To speed up the simulation, close the data browser or turn off the 
display of factory information. 
 
You can re-open the browser by right-clicking anywhere on the EDEM toolbar and 
selecting Data Browser from the pop-up menu. The display of factory information in the 
Data browser can be turned on and off using the controls in the Simulator's Tools > Solve 
Report menu. 

The Auto-update option 

When the auto-update option is selected (from the Viewer controls pane in the Simulator), 
the Viewer is updated for every iteration (time step). Potential particle positions are also 
drawn. Consequently simulation will be slower, however the slow down can be minimized 
by lowering the particle detail. 
 
The particle detail controls are used to determine the number of polygons used to create 
each particle. The greater the number of polygons, the better the appearance of the 
particle. However, if the polygon number is high it will slow down the following: 

 Simulation (if the auto-update option is selected) 

 Animation playback in the Analyst 

 Altering the view in the Viewer (position, rotation or zoom factor).  
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Grid size 

The fewer particles per grid cell, the more efficient the simulator. If there is no more than 
one particle in each grid cell then no contact detection needs to take place so the 
simulation will progress faster. The idealized length of a grid cell is 2Rmin where Rmin is the 
minimum particle radius in the simulation. If this results in more memory allocation than 
available, reduce the number of grid cells to avoid the hugely time-consuming swapping of 
memory.  
 

The grid options are in the Simulator. 

Domain size 

The domain is the area in which simulation takes place and is illustrated by the red box in 
the Viewer. The size of the domain size has an effect on simulation time - the larger the 
domain, the longer the simulation will take to run. Use the auto-update option to 
automatically fit the domain around any sections of geometry defined, thus creating the 
smallest domain possible. Similarly if you are only interested in the activity in a particular 
part of your geometry, reduce the domain to fit around that area. 
 

Please note that sections of geometry should not be placed totally coincident with the edge 
of the domain. Particles are removed as soon as they reach the domain edge, so cannot 
interact with any geometry placed there.  
 

The domain options are in the Geometry pane in the Creator. 

Hardware and Drivers 

Earlier it is shown how titeration is affected by the amount of memory available to the software. 

Of equal importance is the type of memory, the processor(s) and the communication 
between the two. A faster processor is capable of carrying out more calculations per 
second and adding extra processors allows for the total computational load to be divided. 
DEM Solutions has good links with hardware vendors and tests are continuously under 
way on possible speed improvements through hardware.  
 
In addition to the hardware, maintaining up-to-date drivers can also help. 
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EDEM Analyst 

About the EDEM Analyst  

The EDEM Analyst is the post-processor used to examine the results of your simulation. 
Play back your simulation as an animation, graph your results, create a video or export 
data for examination elsewhere.  
 

 
 

 Tabs Pane 

 Viewer 

 Viewer Controls 

 Data Browser 

 Toolbar and Menu Bar 
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Tabs Pane (Analyst)  

The Tabs Pane is displayed on the left side of the EDEM window. It has five tabs: Model, 
Coloring, Selection, Tools, Clipping, and Fields. 

Viewer  

The Viewer displays 3D representations of your particles, geometry, and fields (if 
applicable). The rotation, position and zoom factor of the Viewer are controlled using the 
mouse. 
 
A number of animation controls appear just below the Viewer. See Reviewing Your 
Simulation on page 61 for details. 

Viewer Controls (Analyst)  

The Viewer Controls are used to determine how items are displayed in the Viewer.  
 

 Current Time. Choose the time step displayed in the Viewer. Partial-save time 
steps are shown in a lighter color. 

 View. Controls to change, add, and configure camera views. See Viewer 
Controls (Creator) on page 16. 

 Step Factor. The step factor determines the number of iterations or the amount 
of time the animation controls step through. For example, setting the factor to 5 
iterations will increase the speed of the animation playback as only every fifth 
iteration is displayed. Setting the time factor to every iteration will result in a 
smoother but slower playback. When your simulation contains partial saves (see 
Selective Saves on page 51), setting the step factor to match the partial save 
interval results in a constant display of full-save timesteps. 

 Text. Add descriptive text to the Viewer. Click the + button and enter the text in 

the text field. Choose the text color using the color drop-down list. To position the 
text select the Position Text option and click a location anywhere within the 

Viewer window. To delete text, use the x button. 
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Data Browser (Analyst)   

The Data Browser is an .html page that displays detailed information about your model. 
The information displayed differs between the Creator, Simulator and Analyst. Right click 
anywhere within the Data Browser and choose Save to save the information in an .html 
file. 
 

The Data Browser within the Analyst has the following sections: Description, General, 
Geometry, Particles, Contacts, Bonds, and Selections. 

Description 

The description as defined in the Globals pane. 

General 

 Dimensions. The number of dimensions in your domain. 

 Gravity. Details of the gravity acting in your model as specified in the Globals 
pane. 

 Materials. A list of all materials used in the model and their properties, as 
specified in the Materials Editor. 

 Energy. The total energy in the model at the current time. It is the sum of the 
kinetic energy, potential energy and the energy in any contacts taking place. 

Geometry 

 Domain. The dimensions of the domain as specified in the Geometry pane. 

 Geometry Totals. Details of the number of elements that make up each section 
of geometry. 

 Sections. Each section in the model and its properties are listed. Properties are 
as specified in the Geometry pane. 

Particles 

 Particles. A list of each particle type used in the model and their properties. 
Details of each surface within the particle are also listed. Properties are as 
specified in the Particles pane. 

 Factories. Details of each factory used in the model and their properties. 
Properties are as specified in the Factory pane. The total number of particles 
created by each factory is also listed. 

 Particle totals. The total number of particles in the model at the current time. 
Totals for each particle type are also listed. 
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Contacts 

 Interactions. A list of the interaction types taking place in the model as specified 
in the Materials Editor. 

 Contacts. Lists the total number of contacts in progress at the current time. The 
contacts are broken down into contact types: For example, the number of particle 
A - particle B contacts or particle B - surface A contacts. The total number of 
collisions that have taken place during the time step are also listed. 

Bonds 

 Bond totals. A list of the bond totals, indicating total number of bonds, total 
number of intact bonds, total number of broken bonds, and total intact and 
broken bonds for each particle type. 

Selections 

 Selections. All selections are listed. This section has links to pages with 
information on the selection and its associated queries, list of particles, and 
geometry elements (if applicable). 

 

Analyst Toolbar  

Icon Name Description 

 Creator Click to switch to the Creator. 

 Simulator Click to switch to the Simulator. 

 Analyst Click to switch to the Analyst. 

 Open Click to open an existing model. 

 3D Viewer Click to switch to the 3D Viewer. 

 Create Graph Click to switch to the Graph Creator. 

 Help Click to view the online help. 
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Analyst Menu Bar  

File Menu 

 Open. Open an existing model. 

 Truncate File. Remove sections of data from your model. See Truncating Data 
on page 93 for details. 

 Export. Opens a sub-menu with the following options: 

 Simulation Deck. Export a single full time step from your simulation to 
create a copy as a new EDEM simulation deck (you cannot export from 
partial save time steps). Exporting a deck allows it to be transferred to 
another location and run again using identical simulation parameters. To 
export a simulation deck: 

1. Enter a name for the deck then click Save. 

2. From the Export Options dialog, select the content options: 

 Un-tick the Export Custom Properties option to exclude any custom 
property data from the deck. 

 To export a time step other than the current time step, tick the Set 
Start Time checkbox then enter a starting time in seconds.  

3. Click OK to save the simulation deck. 

 Results Data. Export specified data for analysis. See Exporting Data on 
page 87 for details. 

 Image. Save a copy of the image currently displayed in the Viewer. See 
Working with Images on page 83 for details. 

 Print Image. Print a copy of the image currently displayed in the Viewer.  

 Creator. Select to switch to the Creator. 

 Simulator. Select to switch to the Simulator. 

 Analyst. Select to switch to the Analyst. 

 Recent Files. A list of recently opened files. Select a file to open it. 

 Quit. Quit EDEM. 
 

Tools Menu 

The Analyst’s Tools Menu is the same as for the Creator. See the Creator Tools menu 
on page 19 for details. 

 

Reviewing Your Simulation  

The Analyst is used to review and examine your simulation. A number of animation 
controls appear just below the Viewer. These are used to examine every iteration of your 
simulation. The buttons are: 
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Jump to start 

 
Stop 

 
Jump to end 

 
Play backwards 

 
Step forward  Record animation (video) 

 
Step backward 

 
Play forwards   

 

Note: Close the Data Browser to speed up playback.  

 

Model Tab  

Options in the Model tab are used to configure the display of your model in the Viewer. 
You can enable or disable the display of geometries, particles, contacts, bonds, or 
selection groups (including bins and bin groups). 
 

Note: If there are any display conflicts, the relevant control is highlighted.  

Geometry 

Display options can be applied to all the geometry in your model, to individual sections, 
or to selection groups. The options apply to the geometry or selection group selected in 
the drop-down lists. Once you have set the geometry options, click the Apply button. 

Display by 

Select Type for geometry sections or Selection for geometry in a selection. 

Type/Selection 

Depending on the Display-by drop-down list, select either a geometry section, all 
geometry sections, or a selection. 

Properties by selection 

For selections, enable or disable geometry type display options for the selected 
selection.  

Display checkbox  

Enable or disable the display of the selected section or selection. 

Display Mode 

Choose between filled, mesh or point style display. The mesh option is used to display 
the triangular elements the section is made up of. The points option shows the vertex of 
each element. 
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Figure 4-5: Filled Geometry Figure 4-6: Mesh Geometry  Figure 4-7:  Points Geometry 

Opacity 

Set the opacity level from 0 (fully transparent) to 1 (opaque). 

Particles 

Display options can be applied to all particles, particles of a particular type, or particles in 
a selection group. The options apply to the particle type or selection group selected in 
the drop-down lists. Once you have set the particle options, click the Apply button. 

Display by 

Select Type for types of particles or Selection Group for particles in a selection group. 

Type/Selection Group 

Depending on the Display-by drop-down list, select either a type of particle, all particles, 
or a selection group containing particles. 

Properties by selection group 

For display by selection groups, enable or disable particle type display options for the 
selected selection group. 

Display 

Enable or disable the display of the selected particles or selection group. 
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Representation 

Choose how to represent particles: either default, cone, vector, stream, or template. 
Click the Options button to set further display attributes. 
 

Option Description 

Default By default, particles are displayed 
as they were defined in the Creator.  

Cone Particles are displayed as cones. 
The direction, length and base width 
of the cone can be set to represent 
a variety of particle attributes. 

 Direction. Represents 
velocity, torque, total force, 
angular velocity, or custom 
property (consisting of 
exactly three values) 

 Length. Represents: velocity, total force, moment of inertia, kinetic 
energy, mass, rotational kinetic energy, compressive force, 
torque, volume, angular velocity, or a custom particle property. 

 Base width. Can represent: velocity, total force, compressive 
force, torque, mass, kinetic energy, rotational kinetic energy, 
volume, moment of inertia, angular velocity, charge, electrostatic 
force, or a custom particle property. 

Particle display reverts to standard spheres when EDEM cannot show 
particles as cones (for example, if the selected attribute has no values). 

Vector Particles are displayed as vectors. 
The direction and length of the 
vector can be set to represent a 
variety of particle attributes. 

 Direction. Can represent: 
velocity, torque, total force or 
angular velocity, or custom 
property (consisting of exactly 
three values) 

 Length. Can represent: velocity, total force, moment of inertia, 
kinetic energy, mass, rotational kinetic energy, compressive force, 
torque, volume, angular velocity, or a custom particle property. 
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Option Description 

Stream 

The path of the particle is displayed 
as a stream with variable coloring.  

 Number of Steps. Define the 
number of time steps the 
particles should be streamed 
for. The number indicates 
that the streams will be 
drawn for the previous n time 

steps up to and including the 
current time step. 

 Stream All Steps. Streams are drawn across all time steps. 

 Stream Fade. Fades the color intensity of the streams. 

Template 
Particles are displayed using one of 
the currently imported templates. 
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Contacts and Bonds 

Contacts 

Contacts between different types of particle and between particles and individual 
sections of geometry can all be examined independently.  
 

Select Contact from the Element pulldown then use the Type 1 and Type 2 controls to 
choose a pair of elements. Enable the Display option to show the contacts in the Viewer. 
 

The display can represent the following attributes:  

 Contact Vector 

 Normal Force 

 Normal Overlap 

 Tangential Force 

Refer to Appendix B: Attribute Definitions for more information on attributes. 

Bonds 

Bonding between different types of particle can be examined independently.  
 

Select Bond from the Element pulldown then select the Bond State (either Intact Bond or 
Broken Bond). Use the Type 1 and Type 2 controls to choose a pair of elements. Enable 
the Display option to show the bonds in the Viewer. 

For broken bonds, set the distance threshold to define the distance between the center 
of particles before broken bonds are no longer displayed. 

The display can represent the following attributes:  

 Normal Force 

 Normal Moment 

 Tangential Force 

 Tangential Moment 

Refer to Appendix B: Attribute Definitions for more information on attributes. 

 

 



 EDEM 2.4 User Guide 
 

67 

Coloring  

Use the Coloring tab to color different elements of your model in a variety of ways. You 
can independently color any section of geometry, particle, contact type, bond, or 
selection group (including bins and bin groups). 

Static Coloring 

Static coloring is used to set the standard color 

for any element: For example, a particular 
particle type or geometry in a selection group.  
 
The color applies to whatever element and type 
or group is selected in the Select Element 
section. The figure on the left shows particles in 
three separate selection groups each colored 
differently. 
 

Attribute Coloring 

Attribute coloring is used to color any element 
of the model by a particular attribute: For 
example, the figure on the left shows all 
particles colored by velocity. The particles with 
the greatest velocity are colored red; those with 
the lowest colored blue. 
 
Choose the element to color from the Select 
Element section, then select the attribute to 
color by. 
 

The attributes and their components available for each element are listed in the table 
below. Refer to Appendix B: Attribute Definitions for more information. 
 

Element Attributes  Components 

Particle Angular Velocity  Magnitude, X, Y, Z 

 Compressive force n/a 

 Moment of Inertia  Magnitude, X, Y, Z 

 Kinetic energy n/a 

 Mass n/a 

 Potential energy n/a 

 Rotational kinetic energy n/a 

 Torque  Magnitude, X, Y, Z 

 Total energy n/a 

 Total force  Magnitude, X, Y, Z 

Particle Velocity Magnitude, X, Y, Z 

 Volume n/a 

 Custom property Depends on number of elements 
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Element Attributes  Components 

Geometry Compressive force n/a 

Total force Magnitude, X, Y, Z 

Torque Magnitude, X, Y, Z 

Velocity Magnitude, X, Y, Z 

Custom property Depends on number of elements 

Contact Contact vector 1 Magnitude, X, Y, Z 

Contact vector 2 Magnitude, X, Y, Z 

Normal force Magnitude, X, Y, Z 

Normal overlap n/a 

Tangential force Magnitude, X, Y, Z 

Tangential overlap n/a 

Custom property Depends on number of elements 

Bond Normal force Magnitude, X, Y, Z 

Normal moment Magnitude, X, Y, Z 

Tangential force Magnitude, X, Y, Z 

Tangential moment Magnitude, X, Y, Z 
 

Table 4-1: Attributes for Coloring Elements 

 
A color should also be assigned for the minimum, median and maximum values. 
Elements will be colored depending on whereabouts in the range they fall.  
 

The value range is determined by setting the minimum and maximum attribute values. 
The values can be entered directly or can be read from the model by clicking the update 
buttons. This takes the current maximum and minimum values of the selected attribute 
from the model. If the auto-update options are selected these values will update 
according to which time step is being viewed. 
 

Attribute coloring can only be viewed when the current time step is either a full save or a 
partial save that included the required attribute. 

Smooth Colors 

Coloring of geometry attributes can be smoothed to better visualize the color gradation.  
With Geometry selected from the Element pulldown, select an attribute to color by then 
tick Smooth Colors. Without color smoothing enabled, each geometry triangle is 
displayed with one color only. With smoothing enabled, the color across each triangle is 
interpolated based on the value of the attribute at the nodes. 

Coloring Legend 

Enable the Show Legend option to display a color legend in the Viewer. Select the 
Position Legend option then click anywhere in the Viewer to position it. Click the Legend 
Options button to set the legend’s width, height, number of intervals, alignment and title. 
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Selections and Binning 

Selections allow data to be extracted from a particular area or element in 
the domain. Using selections, you can monitor any element passing through a 
particular area (known as a “bin”) or track particular elements wherever they move 
within the domain. You can then display, color, graph, or export data based on these 
selections and sub-selections. 
 

There are five types of selections: 

 Manual Selection 

 Grid Bin Group 

 Geometry Bin 

 Imported Geometry Bin Group 

 Mass Flow Analysis 

Manual Selections 

A manual selection lets you select and track individual particles, contacts, geometries, 
or bonds. You can then display, color, graph or export data based on these selections. 
You can also define and add queries, as well as display detail in the data browser. 
 

1. From the Selection tab, click the + button then choose Manual Selection. Name 
the new selection. 

2. Click the Enable Manual Selection checkbox. The cursor changes to a crosshair. 

3. Move the pointer into the Viewer. 

4. Single-click your selection, or press and hold the mouse button then drag the 
pointer to draw a selection box. All particle and geometry elements captured by 
the box that match the current filter will be part of the selection. 

 

If an element is not displayed in the Viewer (after being turned off using the controls 
in the Models tab) it will not be captured by the selection box. All selected elements 
are highlighted in orange by default. Additional selection boxes can be drawn to add 
further elements to the selection. 
 

All captured elements are listed in the Manual Selection area. Click the x button to 
remove them completely from the selection. 
 

Select the Display in Data Browser checkbox to add information on elements in the 
selection to the Selection section within the Data browser. 
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This example shows a 
selection group where 
several particles have been 
individually selected. 
Coloring has been applied 
to show Velocity. 

Grid Bin Groups 

A Grid Bin Group splits the model domain into a lattice. Each grid is known as a 
bin group and each cell is known as a bin. Anything in or moving through each bin 
can be monitored. 
 

To create a Grid Bin Group, from the Selection tab click the + button then choose 
Grid Bin Group. Define the selection then click the Apply button to apply 
settings and display the group in the Viewer. 
 

 
Figure 4-10: A Grid Bin Group with a Highlighted Bin at the Center 

 

Grid Selection 

The Grid Selection section is used to define the size and number of cells in the 
bin group. By default the bin group covers the entire domain, however it can be limited 
to a specific area. The number of bins in the group is determined by the number of 
bins along each axis. Empty bins (those containing no elements) can also be removed. 
If the bin becomes non-empty at a different time step it is automatically 
added back into the group. 
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Geometry Bins 

A geometry bin is a bin element based on a Box or Cylinder geometry type. You can link 
its position to any static or dynamic geometry section. The bin is displayed as a mesh of 
blue lines. 
 

To define a geometry bin: 
 

1. From the Analyst, click the Selection tab. 

2. In the Selection Groups area, click + then choose Geometry Bin. Name the new 
bin.  

3. Select the geometry type: either Box or Cylinder. 

4. Set the bin’s properties to define its size, shape, and initial position. For cylinders, 
set the number of sides to determine how many polygons are used to render the 
bin. Fewer polygons are faster to process, but at the expense of accuracy. 

5. Set the filter options to determine what to include in the bin. By default all 
particles are included. 

6. Select the display mode and on-screen query options. For example, set the 
display mode so that the bin is displayed only when it contains particles. 

7. Select whether to link the bin’s position to a geometry element defined in the 
Creator. This links to the center (or zero-point) of the geometry. If the geometry 
has dynamics, the bin will move along with it. 

 

 

 

This example shows a 
geometry bin based on a 
cylinder. The bin indicates 
the number of particles and 
moves with the geometry it’s 
linked to. 
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Imported Geometry Bin Groups 

With the imported geometry bin group you can define a bin group based on an imported 
mesh file or CAD template created in another package. You can then link the bin group’s 
position to any defined geometry. 
 

To define an imported geometry bin group: 
 

1. From the Analyst, click the Selection tab. 

2. In the Selection Groups area, click + then choose Imported Geometry Bin Group. 

3. In the CAD Template Selection section, click the Import button then navigate to a 
CAD template file. When prompted, set the units then tick the Merge Sections 
option to set the template as one bin, or leave it un-ticked to create one bin for 
each geometry element. The imported file must contain only solid geometry 
elements: you cannot import surfaces (non-closed elements such as a plane). 

4. Set the filter options to determine what to include in the bin. By default all 
particles are included. 

5. Select the display mode and on-screen query options. For example, set the 
display mode so that the bin is displayed only when it contains particles. 

6. Select whether to link the bin’s position to a geometry element defined in the 
Creator. If the geometry is dynamic, the bin will move along with it. 

 

 

 

This example shows an 
imported geometry bin linked 
to a moving bucket geometry. 
A query has been added to 
display the average particle 
angular velocity. 

Mass Flow Analysis 

Mass flow rate is the rate at which particles pass through a bin group. It is measured in 
mass over time, for example, tons per hour or kilograms per second. Mass flow analysis 
enables the calculation of the rate of mass flow in a certain volume within the simulation. 
The user creates the volume (a cylinder) and places it within the model domain. 
 
The calculation for mass flow rate for a single timestep is 
 

 

 

 
Where: 

  = Magnitude of the mass flow rate. 
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  = The mass of particle i the selection bin. 

  = The velocity of particle i in the selection bin as a vector. 

  = The length of the cylinder as a unit vector. 
 
For each particle its mass is multiplied by the dot product of its velocity and the unit 
vector of the cylinder from start to end. Each of these per particle values are then 
summed and divided by the length of the bin. The length of the bin is the distance from 
the start point to the end point of the cylinder. 
 
To define the mass flow: 
 

1. From the Analyst, click the Selection tab. 

2. In the Selection Groups area, click + then choose Mass Flow Sensor. Name the 
new mass flow sensor.  

3. Set the mass flow sensor’s properties to define its size, shape, and initial 
position. For cylinders, set the number of sides to determine how many polygons 
are used to approximate the circumference of the cylinder. Fewer polygons are 
faster to process, but at the expense of accuracy. 

4. Set the filter options to determine what to include in the calculation of the mass in 
the bin. By default all particles are included. 

5. Select the display mode and on-screen query options. For example, set the 
display mode so that the bin is displayed only when it contains particles.  

 

 

Selection Queries 

A query is used to define a single element attribute, for example, particle velocity, 
total force on a geometry section or number of collisions. The query information 
can then be displayed in the Viewer and in the Groups section in the Data Browser. 
Bin cells can also be colored according to the results of the query. 
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To define a query, click the Edit button in the Options section. The Selection Query 
Editor is displayed: 
 

 
Figure 4-11: Selection Query Editor 

 

1. Select an element and attribute from the list. The elements are categorized by 
type: contacts, geometry, bonds, and particles. See the table below and 
Appendix B: Attribute Definitions for details. 

2. Use the Type/Section control to choose the section (for geometry elements) or 
type of element the information will be displayed for: For example, an attribute 
relating to particles of type A, a particular section of geometry or a contact 
between two specific particle types. 

3. The Query type option is used to determine the type of data displayed. Choose 
from average, maximum, minimum or total: For example the average velocity or 
the maximum force. This option is only available for certain element attributes 
(see the tables below for details). 

4. Select the component of the attribute you are interested in. Choose from 
Magnitude, X, Y or Z component: For example, the X component of the particle 
velocity or the magnitude of the normal force in a surface-surface contact. This 
option is only available for certain element attributes. 

5. If applicable, select the Specify range option to constrain the data collected to a 
particular value range: For example, particle velocities between 1m/s and 10m/s. 

6. Click the Add button once the query has been fully defined. Multiple queries can 
be created and added to the list. All queries are automatically added to a table in 
the selection’s page in the Data browser. 
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Figure 4-12: A selection with query results (number of particles) displayed on-screen 

 
 
Contacts 
 
Affects all contacts or any combinations of specific particle-particle or particle-geometry 
contacts. 
 

Attribute Query type Component 

Contact vector 1 Average, maximum,  minimum or total Magnitude, X, Y, Z 

Contact vector 2 Average, maximum,  minimum or total Magnitude, X, Y, Z 

Normal force Average, maximum,  minimum or total Magnitude, X, Y, Z 

Normal overlap Average, maximum,  minimum or total n/a 

Number of contacts n/a n/a 

Tangential force Average, maximum,  minimum or total Magnitude, X, Y, Z 

Tangential overlap Average, maximum,  minimum or total n/a 

Custom property Average, maximum,  minimum or total Depends on number 
of elements 

 
Bonds 
 
Affects all bonds or any combinations of specific particle-particle bonds. 
 

Attribute Query type Component 

Normal force Average, maximum,  minimum or total Magnitude, X, Y, Z 

Normal moment Average, maximum,  minimum or total Magnitude, X, Y, Z 

No. of broken bonds n/a n/a 

No. of intact bonds n/a n/a 

Tangential force Average, maximum,  minimum or total Magnitude, X, Y, Z 

Tangential moment Average, maximum,  minimum or total Magnitude, X, Y, Z 
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Geometry 
 
Affects all geometry or a particular section (as specified in the Creator). 
 

Attribute Query type Component 

Compressive force Average, maximum,  minimum or total n/a 

Number of 
geometry elements 

n/a n/a 

Total force Average, maximum,  minimum or total Magnitude, X, Y, Z 

Torque Average, maximum,  minimum or total Magnitude, X, Y, Z 

Velocity Average, maximum,  minimum or total Magnitude, X, Y, Z 

Custom property Average, maximum,  minimum or total Depends on number 
of elements 

 
Particles 
 
Affects all particles or a particular particle type (as specified in the Creator). To 
cumulatively sum the number of particles over a period of time, select the 'Total over 
time' option. As you step forward through the simulation the total number of particles will 
be recorded. Cumulative particle totals for bin groups only works when stepping forward 
through your simulation: if you jump back, the totals may not be accurate.  
 

Attribute Query type Component 

Angular Velocity  Average, maximum,  minimum or total Magnitude, X, Y, Z 

Compressive force Average, maximum,  minimum or total n/a 

Moment of Inertia  Average, maximum,  minimum or total Magnitude, X, Y, Z 

Kinetic energy Average, maximum,  minimum or total n/a 

Mass Average, maximum,  minimum or total n/a 

Number of particles Total-over-time checkbox n/a 

Potential energy Average, maximum,  minimum or total n/a 

Rotational kinetic 
energy 

Average, maximum,  minimum or total 
n/a 

Torque  Average, maximum,  minimum or total Magnitude, X, Y, Z 

Total energy n/a n/a 

Total force  Average, maximum,  minimum or total Magnitude, X, Y, Z 

Velocity Average, maximum,  minimum or total Magnitude, X, Y, Z 

Voidage1 Total n/a 

Volume Average, maximum,  minimum or total n/a 

Custom property Average, maximum,  minimum or total Depends on number 
of elements 

 
 

                                                
1
 Not available with imported geometry bin groups. 
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Type Filter 

The Type Filter section is used to determine which elements in your model are included. 
By default all particles (but nothing else) are included in the group. Elements are 
categorized by type. For any element, click the pulldown menu to select all, none, or 
selected elements: 

 

Element Filter Options 

Particles All Particles, No Particles, Selected Particles 

Geometry All Geometry, No Geometry, Selected Geometry 

Surface - Geometry 
Contacts 

All Surface-Geometry Contacts, No Surface-Geometry 
Contacts, Selected Surface-Geometry Contacts 

Surface - Surface 
Contacts 

All Surface-Surface Contacts, No Surface-Surface 
Contacts, Selected Surface-Surface Contacts 

Surface - Geometry 
Bonds 

All Surface-Surface Contacts, No Surface-Surface 
Contacts, Selected Surface-Surface Contacts 

Surface - Surface 
Bonds 

All Surface-Surface Bonds, No Surface-Surface Bonds, 
Selected Surface-Surface Bonds 

 

For selected elements, tick the checkbox for all elements to include. 

 
Representation 

Display Mode 

For bins and bin groups, the display mode determines how bins are rendered in the 
viewer. 

 Always - All bins are always displayed. 

 If Populated - Bins are only displayed when they contain elements enabled in 
the type filter. 

 Never - Bins are not displayed. When several selections exist this can cause 
confusion, so you can choose this option to turn off specific selections. 

Display Options 

Display options let you specify which query is displayed in the viewer, as well as set 
highlighting and coloring options for individual bins (sub-selections). Click the Edit button 
to open the Display Options. 

On Screen Display 

For bins and bin groups, tick the On Screen Query checkbox then select which selection 
group query to display in the viewer.  
 
For grid and geometry template selections, select options to highlight and color sub-
selections. Bins can be colored in one of two ways: Highlighting individual bins, or 
coloring bins by a specific query. 



EDEM 2.4 User Guide 

78 

Highlight Sub-Selection 

Select which particular bin in the bin group to highlight. Only one bin can be highlighted 
at a time. Bins in grid bin groups are identified using an ID matrix; bins in imported 
template selections use the geometry names from the imported file (if available). 

Sub-Selection Coloring 

Bin groups can be colored according to any pre-defined query: For example, bins could 
be colored by the number of collisions taking place in them, or by the average speed 
of the particles they contain. 
 

 Choose a query from the drop-down list.  

 Set the value range. This is determined by setting the minimum and maximum 
query values. The values can be entered directly or can be read from the model 
by clicking the update buttons. This takes the current maximum and minimum 
values of the selected query. If the auto-update options are selected, these 
values will automatically update according to the time step being viewed. Bins will 
then be colored depending on whereabouts in the range they fall. The colors 
used are fixed from blue (minimum), through green, to red (maximum). 

 Select the Legend option to display a color legend in the Viewer. 

 Use the opacity option to vary the opacity of the bin coloring. 
 
 

 
Figure 4-13: A bin group colored by average particle velocity. Bin cells have an opacity of 0.2. 
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Tools Tab 

Ruler  

The ruler measures the distance between two points. Use it to display the distance 
between elements in the Viewer.  

 

1. From the Tools tab, click the Ruler tab. 

2. Click the Enable checkbox. 

3. For the start point, select what to link to. 
You can link to a particle, a geometry, or 
you can manually define a point in space. 
For example, to link to a particle: 

a. Click the Link To Particle checkbox.  

b. Click the Pick Particle button. The 
cursor changes to a cross-hair. 

c. Click on a particle in the viewer to select the particle to link to. 

4. Repeat the above step to set the end point. 

The Current Distance between the two points is displayed at the bottom of the Tools tab. 

Protractor  

The protractor measures the angle between 
elements in the viewer. 

1. From the Tools tab, click the Protractor 
tab. 

2. Click the Enable checkbox. 

3. For the start point, select what to link 
to. For example, to link to a particle: 

a. Click the Link To Particle 
checkbox.  

b. Click the Pick Particle button. 
The cursor changes to a cross-
hair. 

c. Click on a particle in the viewer 
to select the particle to link to. 

4. Repeat the above step to set the end point and axis. 

The Current Angle between the two points is displayed at the bottom of the Tools tab.   



EDEM 2.4 User Guide 

80 

Domain Grid  

The domain grid is a visual aid used to indicate the scale of your model. A grid can be 
added to each side of the domain (+X, +Y, +Z, -X, -Y and -Z). The number of intervals in 
each grid is also specified. The coordinates of each vertex and the length of each edge 
are shown.  
 

The figure below shows a model with 10 interval +X and +Y grids displayed: 
 

 
 

Figure 4-21: Example Model with Domain Grid 

Clipping  

Clipping is used to remove ('clip') areas of the model that are not currently of interest. A 
model can be clipped in three ways - using planes, slices or the domain boundaries. A 
clip group is a collection of one or more planes, slices or domain boundaries (though it 
can only contain clips of one type). A model may have any number of clip groups: For 
example, the model of a pipe may have two clip groups, one containing different slices of 
the pipe and another containing an area of pipe constrained by a number of planes. 
 

Create a clip group by clicking the + button, then choose the clipping type from the 

Active Sets drop-down list. The planes, slices or boundaries can then be defined in the 
lower half of the Clipping Elements section. The top half of this section contains the list 
used to determine which elements within your model are affected by the clipping group: 
For example, you may wish to only clip the geometry and leave the particles intact. By 
default all elements are included in the group and hence are colored green. The 
elements are categorized by type - particles, geometry, contacts, and bonds. Double 
click on any element to remove it from the group. Its listing will turn black indicating its 
exclusion. An element can be added into the group by double clicking on it a second 
time.  
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The figure below shows a model of a pipe where geometry has been included in a slice 
and particles have been excluded. 
 

 
Figure 4-14: Sliced pipe 

Planes 

A planes clipping group can contain up to six individual planes. Choose a plane from the 
Elements drop-down list in the Clipping Elements section. The plane is then defined by 
its orientation and its distance from the center of the model. The section of the model 
that falls on one side of the plane will be clipped from the model. Simply negate the 
orientation of the plane to switch which side of the model is removed.  
The Visual Representation option can be used to display a preview of the plane in the 
Viewer. Select the Enable Plane option to activate the plane and clip a section from the 
model. 

 
Figure 4-15: A Model Before Clipping 

 
Figure 4-16: A Model After Plane Clipping 
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Slices 

A slices clipping group can contain up to three individual slices. Choose a slice from the 
Elements drop-down list in the Clipping Elements section. The slice is then defined by its 
orientation, distance from the center of the model and depth. The section of the model 
that falls outside the slice will be clipped from the model. The Visual Representation 
option can be used to display a preview of the slice in the Viewer. Select the Enable 
Slice option to activate the slice and clip an area of the model. 
 

 
Figure 4-17: A Model Before Clipping 

 
Figure 4-18: A Model After Slice Clipping  

 

Domain Boundaries  

Each side of your domain can be used to clip your model in a Domain Boundaries 
clipping group. Choose a side from the Elements drop-down list in the Clipping Elements 
section and the select the Enable Slice option to clip the area of the model outside of the 
domain on that side. 
 

 
Figure 4-19: A Model Before Clipping 

 
Figure 4-20: A Model After Clipping 
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Saving Images  

Full-color images can be exported at a single time step or over a range of time steps. 

Saving a Single Image 

The image displayed in the Viewer can be exported and saved as a .png (table network 
graphic) or .bmp (bitmap).  

1. Use the animation controls to choose the image you wish to export.  
2. Use the camera controls to set the angle. 
3. Use the controls in the Tools menu to turn on or off the display of the axis key, 

bounding box or timestamp. Increase the particle detail to improve the 
appearance of particles. 

4. Select File > Export > Image. The Save Image dialog will appear. 

 Select Filename. Set the file name and save location. 

 Quality. Choose one of the following: 

 

 

 

1. Screen Grab. If this option is selected, the image exported will 
be the same dimensions as the Viewer. 

2. Screen Viewing. If this option is selected, the image exported is 
web quality. 
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3. High Resolution. If this option is selected, the image exported 
is print quality, and width and height can be specified in inches, 
millimeters, or pixels. Also, the resolution can be specified in dpi. 

 Width. Set the image width if the screen grab option is not selected. 

 Height. Set the image height if the screen grab option is not selected. 

Saving Multiple Images 

To save a range of time steps: 

1. Use the animation controls to choose the first image in the range and display it in 
the Viewer. Images will be exported from this point onward.  

2. Set the step factor in the Viewer controls pane. This determines how often an 
image is exported: for example every fifth time step or every 0.0001s.  

3. Use the controls in the Tools menu to set the axis key, boundary box and time 
stamp. Increase the particle detail to improve the appearance of particles. 

4. Click the blue record animation button       in the viewer. The Export 
Images/Video dialog is displayed. 

 Export Format. Set the export format to Images. 

 Filename. Set the base file name and save location. Each image will be 
given the base name plus a numeric suffix. 

 Frame Width. Set the width of each image. For example, 640 pixels. 

 Frame Height. Set the height of each image. For example, 480 pixels. 

 Set to Screen Size. Click the screen grab button  to set the width and 
height to match the screen size. The image exported will be the same 
dimensions as the Viewer. 

5. Click OK. The record animation button turns red:  
6. Use the animation controls to play or step through the simulation. 
7. When finished, click the record animation button again to stop recording. 

 

Creating Videos 

EDEM can export videos as AVI, WMV (Windows Media Video), or EnSight Video files. 
You can specify encoding quality, frame rates and which compressor (codec) to use. A 
video can contain multiple display modes (for example, change the camera angle and 
particle representation halfway through the video) and even contain different simulations 
in the same video. 

Prepare to Record a Video 

1. Use the animation controls to select a start point. The video will be exported from 
this point onward.  

2. If necessary, set the step factor in the Viewer controls pane.  
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3. Use the controls in the Tools menu to set display of the axis key, boundary box 
and time stamp. Increase the particle detail to improve the appearance of 
particles. 

4. Click the blue record animation button       in the viewer. The Export 
Images/Video dialog is displayed: 

 
 

Video Configuration 

Export Format 

Set the export format to either EnSight Video, AVI Video, or Windows Media Video.  

 Select EnSight Video to save the video as a .evo file. The video can then be 
viewed using CEI’s EnVideo, or edited using EnVe. 

 Select AVI Video to save the video as a .avi file. Save your video as an AVI when 
you want to use a particular codec (compressor) or when you need a high degree 
of video configuration.  You can use any codec installed on your system (for 
example, Cinepak, DivX, Xvid, or H.264). 

 Select Windows Media Video (WMV) to use Microsoft’s video codecs. A WMV file 
is better suited for sharing, since it should play on any PC without the need to 
install video codecs. You can also set a constant bitrate, useful for streaming the 
video from a website. 

Select Codec 

Select the codec to use or select uncompressed to not use any video compression. The 
list of  codecs available depends on those installed on your system and on which 
operating system you are running EDEM. Be sure the system on which you intend to 
playback the video also has the same codec installed. 
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 For AVI Video, select a codec then (if available) click the configure button to set 
any additional codec options. 

 For EnSight Video, select Motion-RLE for lossless video files or select Motion-
JPEG for compressed video.  

NOTE: DEM Solutions does not provide support for external codecs developed by third 
parties. Refer to the codec’s documentation or developer’s website for assistance. 

Video Options 

Set the frame options and encoding quality as necessary. 

 Frame Width. Set the width of the video. For example, 640 pixels. 

 Frame Height. Set the height of the video. For example, 480 pixels. 

 Frame Rate. Set the frame rate. For example, 25 fps. A lower frame rate 
decreases the size of the video. 

 Set to Screen Size. Click the screen grab button       to set the width and height 
to match the screen size. The video exported will be the same dimensions as the 
Viewer. 

 Compression Quality. Use the slider to set the encoding quality (where 
available). The higher the quality, the larger the size of the video. 

 Use Target Data Rate. Tick this checkbox to specify a Constant Bitrate (CBR). 
You would typically use this when you want to stream the video from a website. 

 Force Keyframes. Tick this checkbox then set how often to write a keyframe to 
the video. Because video compression only stores incremental changes between 
frames, forcing keyframes can result in a video that is easier to fast-forward or 
rewind. 

 

Record the Video 

1. Click OK. The record animation button turns red:  

2. Use the animation controls to play or step through the simulation. While 
recording, you can change whatever is displayed in the viewer. Any changes are 
recorded in the video. For example, you can: 

 Change the camera or move, rotate and zoom the display 

 Change the display mode, opacity, and particle representation 

 Modify attribute coloring and legends 

 Add different labels at different timesteps 

 Load a completely different simulation 

3. When finished, click the record animation button again to stop recording. 
 
Use a media player (such as Windows Media Player or VLC media player) to view the 
saved video. 
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Exporting Data  

Data collected during your simulation can be exported for analysis. Data can be exported 
from a single time step, a range of time steps, from all elements in your model or just 
from a selection or bin group. 
 

Exporting data is carried out using queries. A query is used to define a single element 
attribute: For example, a query could be set up to extract the x-position of particles of 
type A in your model. Multiple queries can be grouped together under one Configuration 
ID and exported to a single file. 

Creating a Configuration 

Export data using the Export Data Dialog (File > Export > Results Data). 
 

 
 
 

1. Click on the + button to create a new Configuration ID. Multiple queries can be 

created within a single Configuration. In addition, multiple configurations can be 
created for any model: For example, one configuration may contain a number of 
queries relating to particles whilst another might have queries solely relating to 
contacts. Configurations can be edited at any point: For example, new queries 
added or redundant ones removed. 

2. Select the output file format: Ensight (.case) or Text (.csv). For Ensight files, be 
sure the total number of characters (filename and directory) is not more than 72. 

3. Give the configuration a title and enter a file name and location. 
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General Settings 

Options 

Output Averages, Maximums, Minimums and Totals in Columns.  
This determines how data is laid out in the exported file. If this option is selected, data 
will be separated and extracted in unlabelled columns. The figures below both show a 
sample of some exported data. The data is the same in each case. In the first figure, the 
data is presented with this option not selected. The second figure shows it with the 
option selected. 
 

 
Figure 4-23: Column Option Not Selected 

 

 
Figure 4-24: Column Option Selected 

 
Output Domain 
This option is only available when exporting data to an EnSight file. If selected, 
information on the domain will be exported with the data. If it is not, a new domain will be 
created automatically when the file is loaded in EnSight. 
 
Delimiter and Line Break 
If you are exporting to a text file, optionally change the delimiter to use and set whether 
to start a new line after X columns. By default, EDEM inserts a line break at 256 columns 
(the maximum allowable by Microsoft Excel). 

Part Selection 

This section is only active when exporting data to an EnSight file.  
Choose to export data on all elements in your model or just from specified ones. The 
elements are categorized by geometry sections and particle types. Information on 
contacts cannot be exported. Double click on any element to remove it from the group. 
Its listing will turn black indicating its exclusion. An element can be added into the list by 
double clicking on it a second time.  

Time Steps 

Data can be extracted from all time steps in your simulation or from a defined range. If a 
time step is from a partial save (indicated by the timestep being grayed-out), data for the 

selected attributes may not be available. This is indicated by n/a in the exported file. 
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Creating a Query 

Queries define what information is exported. A configuration can contain multiple 
queries, each of which defines one data attribute.  
 

 
Figure 4-25: The Query Tab 

 

Click on the Queries tab and click the + button to create a new query. The attributes that 

can be exported are listed under the element they relate to (collisions, contacts, particles 
or geometry). Click on any attribute to select it and then select the component of that 
attribute you are in interested in: For example the magnitude of a contact vector. All 
available attributes and their components are listed in the tables below. 
 

Next choose the geometry section or type of particle or contact you want to export data 
for: For example choose only collisions between certain particle types, or the force on a 
particular geometry section.  
 

Data can be extracted on all elements of the selected type (or geometry section) or it can 
be limited to just those contained within a particular bin group or selection group. This 
can be selected using the Selection drop-down list where all bin and selection groups 
that have been created are listed. Enable the Apply to Sub-Selections checkbox to 
export a separate query for each bin in a group (if defined), rather than one combined 
query for the entire group. 
 

The Query Type option is used to determine which data values will be exported for a 
particular attribute: For example, if the query has been set up to export the velocity of 
particles of type A you could choose to export the maximum, minimum or average 
velocity per time step. The following data is exported for each query type: 

 Standard. The value of the attribute for every element of the selected type for 
each time step in the defined range: For example, the velocity of every particle at 
each time step. 

 Total. The sum of the values of the attribute for every element of the selected 
type: For example, the total velocity of all particles per time step. The total can be 
calculated per time step or over the range specified in the General settings 
section. 
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 Maximum. The maximum value of the attribute across all elements of the 
selected type for each time step in the defined range: For example, the maximum 
particle velocity per time step. The maximum can be calculated and exported per 
time step or over the range specified in the General settings section. 

 Minimum. The minimum value of the attribute across all elements of the selected 
type for each time step in the defined range: For example, the minimum particle 
velocity per time step. The minimum can be calculated and exported per time 
step or over a specified range. 

 Average. The average value of the attribute across all elements of the selected 
type for each time step in the defined range: For example, the average particle 
velocity per time step. The average can be calculated per time step or over a 
specified range. 

 

The final option is Specify Range. This is used  to specify a value range for the data 
exported. In other words, limiting the export to data that falls between two specified 
values. For example, only exporting particle velocity data for particles traveling between 
3m/s and 5m/s. 
 

Further queries can be created in the same way. Once all queries have been set up, 
click the Export button to export your data to your specified file. Refer to Appendix B: 
Attribute Definitions for more information on attributes. 
 
Collision Elements 
 
Affects all or any combination of specific particles types or geometry sections. 
 

Attribute Components Query Type 

Average normal force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Average tangential force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Duration n/a Standard, Avg., Min. or Max. 

End time n/a n/a 

ID n/a n/a 

ID Element n n/a n/a 

Maximum normal force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Maximum tangential force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Normal energy loss n/a Standard, Avg., Total, Min. or Max. 

Number of collisions n/a n/a 

Position X, Y, Z n/a 

Relative velocity Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Relative velocity normal Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Relative velocity 
tangential 

Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Start time n/a n/a 

Tangential energy loss n/a Standard, Avg., Total, Min. or Max. 

Total energy loss n/a Standard, Avg., Total, Min. or Max. 

Velocity of element A Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Velocity of element B Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 
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Contacts Elements 
 
Affects all or any combination of specific particles types or geometry sections. 
 

Attribute Components Query Type 

Contact vector 1 Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Contact vector 2 Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Normal force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Normal overlap n/a Standard, Avg., Total, Min. or Max. 

Number of contacts n/a Avg., Total, Min. or Max. 

Position X, Y or Z n/a 

Tangential force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Tangential overlap n/a Standard, Avg., Total, Min. or Max. 

Custom property Depends on number 
of elements 

Standard, Avg., Total, Min. or Max. 

 
Bond Elements 
 
Affects all or any combination of specific particles types. 
 

Attribute Components Query Type 

End time n/a n/a 

Normal force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Normal moment Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

No. of broken bonds n/a n/a 

No. of intact bonds n/a n/a 

Tangential force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Tangential moment Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

 
Geometry Elements 
 

Affects all or any individual section (as specified in the Creator). 
 

Attribute Components Query Type 

Compressive force n/a Standard, Avg., Total, Min. or Max. 

ID n/a n/a 

Node n X, Y, Z n/a 

Position X, Y, Z n/a 

Surface Normal Magnitude, X, Y, Z n/a 

Torque Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Total force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Velocity Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Custom property Depends on number 
of elements 

Standard, Avg., Total, Min. or Max. 
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Particle Elements 
 

Affects all or any individual particle type (as specified in the Creator). 
 

Attribute Components Query Type 

Angular velocity Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Compressive force n/a Standard, Avg., Total, Min. or Max. 

ID n/a n/a 

Moment of Inertia Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Kinetic energy n/a Standard, Avg., Total, Min. or Max. 

Mass n/a Standard, Avg., Total, Min. or Max. 

Number of particles n/a Avg., Total, Total over time, Min. or Max. 

Orientation n/a n/a 

Position X, Y or Z n/a 

Potential energy n/a Standard, Avg., Total, Min. or Max. 

Rotational kinetic 
energy 

n/a Standard, Avg., Total, Min. or Max. 

Torque Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Total energy n/a Standard, Avg., Total, Min. or Max. 

Total force Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Velocity Magnitude, X, Y, Z Standard, Avg., Total, Min. or Max. 

Volume n/a Standard, Avg., Total, Min. or Max. 

Custom property Depends on 
number of elements 

Standard, Avg., Total, Min. or Max. 
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Truncating Results  

The Truncate option is used to remove results data (time steps) from your simulation. 
Data can be removed entirely, or simply 'thinned out' by removing every nth result. 
 

Select File > Truncate File. The Truncate file dialog is displayed: 
 

 
 
Set the Start and End Times. This defines the times steps between which you would like 
to remove data. Only full time steps can be truncated: you cannot truncate time steps 
from partial saves. 

Set the Step Factor. A factor can be selected from the list or a new value entered 
directly. This determines how often a time step in the range is removed. If the step factor 
is set to one, every time step will be removed thus removing all data in the specified 
range. If it is set to greater than one, the data in the range will effectively be 'thinned out'. 
The greater the step factor, the more data is removed. 

By default the selected data will be truncated from the current simulation deck. Tick 
Create New EDEM Simulation Deck to truncate to a new simulation deck. The original 
deck is unaffected. 

 

Graphing 

Creating Graphs 

Data collected during your simulation can be graphed in a number of ways. Select the 
Analyst then switch between 3D Viewer and graph mode using the toolbar buttons: 
 

 
Figure 4-26: The 3D Viewer and Graph Buttons 
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When you select graph mode, the Graph tab replaces the standard Tabs pane and the 
graph is displayed in the Viewer. The Graph pane has four individual tabs, one for each 
type of graph: 
 

 Histogram 
 Line Graph 
 Scatter Plot 
 Pie Chart 

 

Note: Only one graph of each type can be created at any one time. 

Creating a Histogram (Bar Chart) 

A histogram is a graphical display of tabulated frequencies. For example, the figure 
below is a histogram which shows the number of particles traveling in particular velocity 
ranges. A tabular version of the data is also included. 
 

 
Figure 4-27: Data Showing the Distribution of Particle Velocities 
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Selecting the Elements to Graph 

The Select Element section is used to determine which elements to collect data from. 
Choose the group or type of elements you are interested in.  
 

Group Type 

Particle All or any individual particle type (as specified in the Creator) 

Geometry All or any individual section (as specified in the Creator) 

Contact All or any combination of specific particle types or geometry sections 

Collision All or any combination of specific particle types or geometry sections 

Bond All or any combination of specific particle types 

Configuring the X-Axis 

Click on the X-axis tab then select the attribute and component to plot on the x-axis. The 
attributes available in the list will depend on the elements previously selected. The table 
below shows the attributes and components available for each element. Refer to 
Appendix B: Attribute Definitions for more information on attributes. 
 

Element Attribute Components 

Particle Angular velocity Magnitude, X, Y, Z 

 Compressive force n/a 

 Distance Define reference object* 

 Kinetic energy n/a 

 Mass n/a 

 Potential energy n/a 

 Rotational kinetic energy n/a 

 Time n/a 

 Torque Magnitude, X, Y, Z 

 Total energy n/a 

 Total force Magnitude, X, Y, Z 

 Velocity Magnitude, X, Y, Z 

 Volume n/a 

 Custom property Depends on number of elements 

Geometry Time n/a 
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Element Attribute Components 

Contact Contact vector 1 Magnitude, X, Y, Z 

Contact vector 2 Magnitude, X, Y, Z 

Distance Define reference object* 

Normal overlap n/a 

Normal force Magnitude, X, Y, Z 

Tangential force Magnitude, X, Y, Z 

Tangential overlap n/a 

Time n/a 

Custom property Depends on number of elements 

Collision Average normal force Magnitude, X, Y, Z 

Average tangential force Magnitude, X, Y, Z 

Distance n/a 

Duration n/a 

Maximum normal force Magnitude, X, Y, Z 

Maximum tangential force Magnitude, X, Y, Z 

Normal energy loss n/a 

Number of collisions n/a 

Relative velocity Magnitude, X, Y, Z 

Relative velocity normal Magnitude, X, Y, Z 

Relative velocity tangential Magnitude, X, Y, Z 

Tangential energy loss n/a 

Time n/a 

Total energy loss n/a 

Velocity element A**  Magnitude, X, Y, Z 

Velocity element B Magnitude, X, Y, Z 

Bond Normal force Magnitude, X, Y, Z 

Normal moment Magnitude, X, Y, Z 

Tangential force Magnitude, X, Y, Z 

Tangential moment Magnitude, X, Y, Z 

Time n/a 
 
* If the attribute is set to Distance you must define a point or plane from which the distance is measured. When distance is 
selected the Define Reference Object section of the pane will be activated. Choose Point or Plane and define its position 
and, for a plane, its distance from the origin.  
 
** The velocity of the first element in the collisions. Similarly for Velocity element B. 
 

The x and y axes are related. The attribute you choose to measure on the x-axis will limit 
those available to measure on the y-axis. Similarly if the y-axis is configured first the 
attributes available on the x-axis will be limited. 
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Configuring the Y-Axis 

Click on the Y-axis tab and select the element attribute and component to be plotted on 
the y-axis. The attributes available in the list will depend on the elements previously 
selected and the attribute being measured on the x-axis. A component type can also be 
selected for certain attributes. This is used to determine which value will be graphed for 
a particular attribute component: For example, maximum, minimum or average particle 
velocity. The table below shows the range of attributes, components and component 
types available for each element. Refer to Appendix B: Attribute Definitions for more 
information on attributes. 
 

Element Attribute Components Type 

Contact Contact vector 1 Magnitude, X, Y, Z Average, Max or Min 

Contact vector 2 Magnitude, X, Y, Z Average, Max or Min 

Distance Define ref. object* Average, Max or Min 

Normal force Magnitude, X, Y, Z Average, Max, Min, or Total 

Normal overlap n/a Average, Max or Min 

Number of contacts n/a Total or Total in Range** 

Tangential force Magnitude, X, Y, Z Average, Max, Min, or Total 

Tangential overlap n/a Average, Max or Min 

Custom property Depends on no. of 
elements 

Average, Max, Min, or Total 

Collision Average normal force Magnitude, X, Y, Z Average, Max, Min, or Total 

Average tangential 
force 

Magnitude, X, Y, Z Average, Max, Min, or Total 

Distance Define ref. object* Average, Max or Min 

Duration n/a Average, Max or Min 

Maximum normal 
force 

Magnitude, X, Y, Z Average, Max, Min, or Total 

Maximum tangential 
force 

Magnitude, X, Y, Z Average, Max, Min, or Total 

Normal energy loss n/a Average, Max, Min, or Total 

Number of collisions n/a Total or Total in Range** 

Relative velocity Magnitude, X, Y, Z Average, Max, Min, or Total 

Relative velocity 
normal 

Magnitude, X, Y, Z Average, Max, Min, or Total 

Relative velocity 
tangential 

Magnitude, X, Y, Z Average, Max, Min, or Total 

Tangential energy 
loss 

n/a Average, Max, Min, or Total 

Total energy loss n/a Average, Max, Min, or Total 

Velocity of element A Magnitude, X, Y, Z Average, Max, Min, or Total 

Velocity of element B Magnitude, X, Y, Z Average, Max, Min, or Total 
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Element Attribute Components Type 

Geometry Compressive force n/a Average, Max, Min, or Total 

Distance n/a Average, Max or Min 

Torque Magnitude, X, Y, Z Average, Max, Min, or Total 

Total force Magnitude, X, Y, Z Average, Max, Min, or Total 

Velocity Magnitude, X, Y, Z Average, Max, Min, or Total 

Custom property Depends on no. of 
elements 

Average, Max, Min, or Total 

Particle Angular velocity Magnitude, X, Y, Z Average, Max, Min, or Total 

Compressive force n/a Average, Max, Min, or Total 

Distance Define ref. object* Average, Max or Min 

Kinetic energy n/a Average, Max, Min, or Total 

Mass n/a Average, Max, Min, or Total 

Number of particles n/a Total or Total in Range** 

Potential energy n/a Average, Max, Min, or Total 

Rotational kinetic 
energy 

n/a Average, Max, Min, or Total 

Torque Magnitude, X, Y, Z Average, Max, Min, or Total 

Total energy n/a Average, Max, Min, or Total 

Total force Magnitude, X, Y, Z Average, Max, Min, or Total 

Velocity Magnitude, X, Y, Z Average, Max, Min, or Total 

Volume n/a Average, Max, Min, or Total 

Custom property Depends on no. of 
elements 

Average, Max, Min, or Total 

Bond Normal force Magnitude, X, Y, Z Average, Max, Min, or Total 

Normal moment Magnitude, X, Y, Z Average, Max, Min, or Total 

No. of broken bonds n/a Total, Total in range 

No. of intact bonds n/a Total, Total in range 

Tangential force Magnitude, X, Y, Z Average, Max, Min, or Total 

Tangential moment Magnitude, X, Y, Z Average, Max, Min, or Total 

 
* If the attribute is set to Distance you must define a point or plane from which the distance is measured. When distance is 
selected the Define Reference Object section of the pane will be activated. Choose the point or plane from which the 
distance should be measured. A point is defined by its xyz position and a plane by its orientation and distance from the 
origin.  
 
** When the axis is set to measure the number of particles or number of contacts, it is possible to graph either the total 
number of particles/contacts or the total number in a defined range: For example, counting only those particles with a 
mass between 0.1kg and 0.2kg or velocity between 2m/s and 5m/s. When the Total in Range option is selected the 
Secondary Attribute section of the pane is activated. Choose the attribute and component you wish to restrict the range 
by and enter the maximum and minimum values of that range. 
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Settings 

Time Step 

Graphs can be created for elements in a particular time step or over a range of time 
steps. By default the Current Time step option is selected. The current time step can be 
changed using the Current Time control in the Viewer control pane at the right of the 
screen. For example, the figure below shows two histograms each showing the number 
of particles traveling in particular velocity ranges. The graph on the left is for one time 
step, so each particle is only counted once. The graph on the right is for a range of ten 
time steps. The velocity of the particles may change between time steps and therefore 
be counted more than once: For example, a particle traveling at 4.92 m/s in the first time 
step and 5.0 m/s for all subsequent time steps will be counted once in the 4.91-4.93 
column and nine times in the 4.99-5.01 column. 
 

 
Figure 4-28: Histograms Showing the Distribution of Particle Velocities.  

 
Unselect the Current Time Step to set a different start and end time. Grayed-out 
timesteps indicate partial saves and may not contain all the data you want to plot. 

Axis Range 

The x and y axis ranges can be determined automatically (from the values of the 
attributes selected) or entered manually. The number of intervals on each axis should 
also be defined. A greater number of intervals increases the accuracy of the chart. 

Display Options 

Click the Display Options button to open the dialog.  

 Title. Set the graph title. 

 X-label, Y-label. Can be determined automatically or entered manually. 

 Show grid. Turn the interval grid on and off. 

 Show average value. Turn the display of a horizontal line showing the average 
value on and off.  

 Show minimum value. Turn the display of a horizontal line showing the 
minimum value on and off.  

 Show maximum value. Turn the display of a horizontal line showing the 
maximum value on and off.  
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Create the Graph 

Create the graph once the axes have been configured and the time step and display 
options set. Click on the Create Graph button to draw the graph. Use the Clear Graph 
button to clear it. If any setting is altered (including changing the units) click the Create 
Graph button to view the graph with the changes.  
 

To save the graph data, right-click on the graph then select Export as Text. 

Drawing a Line Graph  

A line graph is used to measure any variable over time. That is, how the value of a 
particular variable changes over a specified time. 
 

For example, the figure below is a line graph which shows the number of particles 
present in the model over a particular time. It clearly shows a large number of particles 
created in the first 0.0334s followed by a small increase over the next 0.0666s and finally 
a second large increase in the final 0.034s.  
 

 
Figure 4-29: Line Graph Showing the Number of Particle in a Model  

Selecting the Elements to Graph 

The Select Element section is used to determine which elements in your model to collect 
data from. Choose the group of elements, the type of elements within that group and 
which selection of those elements you are interested in.  

Configuring the X-Axis 

Click on the X-axis tab. In a line graph the X-axis always measures time. Use the Start 
and End controls to set the range of time over which to plot your data. Grayed-out 
timesteps indicate partial saves and may not contain all the data you want to plot.  

Set the number of intervals on the axis: a greater number of intervals increases the 
accuracy of the chart. Set the maximum number of points to display. Reducing the 
number of points may make the graph more readable. 
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Configuring the Y-Axis 

Click on the Y-axis tab and select the element attribute and component to be plotted on 
the y-axis. The attributes available in the list will depend on the elements previously 
selected. A component type can also be selected for certain attributes. This is used to 
determine which value will be graphed for a particular attribute component: For example, 
maximum, minimum or average particle velocity.  

Note that if you are graphing the number of elements (i.e. number of particles, contacts 
or collisions) then any interpolated data points (those constructed from the discrete set of 
known data points) are rounded down to the nearest whole number. Refer to Appendix 
B: Attribute Definitions for more information on attributes. 
 
Element attribute options are the same as for a Histogram (with the exception of 
collisions). See Configuring the Y-Axis on page 97 for details. 
 

Settings 

See Settings on page 99. 

 

Drawing a Scatter Plot 

A scatter plot is a way of displaying the distribution of two variables in relation to each 
other. The value of one variable is measured on the X axis and the values of the other 
on the Y axis. A wide scatter of the plots denotes poor correlation between the two 
variables. If the two variables are perfectly correlated, then all the plots will fall on the 
diagonal (regression line).  
 

For example, the figure below is a scatter plot which shows the velocity of a set of 
particles as they travel away from a specified point. The plots are clearly scattered 
around the regression line indicating that the two variables are well correlated. The 
further a particle travels from the specified point, the greater its velocity. 
 

 
Figure 4-30: Scatter Plot Showing Two Well Correlated Variables 
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Selecting the Elements to Graph 

The Select Element section is used to determine which elements in your model to collect 
data from. Choose the group of elements, the type of elements within that group and 
which selection of those elements you are interested in.  
 

Configuring the X-Axis 

Click on the X-axis tab and select the element attribute and component to be plotted on 
the x-axis. The attributes available in the list will depend on the elements previously 
selected. Refer to Appendix B: Attribute Definitions for more information on attributes. 
 

Element Attribute Components 

Contacts Contact vector 1 Magnitude, X, Y, Z 

Contact vector 2 Magnitude, X, Y, Z 

Distance Define reference object* 

Normal force Magnitude, X, Y, Z 

Normal overlap n/a 

Position X, Y, Z 

Tangential force Magnitude, X, Y, Z 

Tangential overlap n/a 

Custom property Depends on number of elements 

Collisions Average normal force Magnitude, X, Y, Z 

Average tangential force Magnitude, X, Y, Z 

Distance n/a 

Duration n/a 

Maximum normal force Magnitude, X, Y, Z 

Maximum tangential force Magnitude, X, Y, Z 

Normal energy loss n/a 

Position X, Y, Z 

Relative velocity Magnitude, X, Y, Z 

Relative velocity normal Magnitude, X, Y, Z 

Relative velocity tangential Magnitude, X, Y, Z 

Tangential energy loss n/a 

Total energy loss n/a 

Velocity element A**  Magnitude, X, Y, Z 

Velocity element B Magnitude, X, Y, Z 

Geometry Compressive force n/a 

Distance n/a 

Position X, Y, Z 

Torque Magnitude, X, Y, Z 

Total force Magnitude, X, Y, Z 

Velocity Magnitude, X, Y, Z 

Custom property Depends on number of elements 
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Element Attribute Components 

Particle Angular velocity Magnitude, X, Y, Z 

Compressive force n/a 

Distance Define reference object* 

Kinetic energy n/a 

Mass n/a 

Position X, Y, Z 

Potential energy n/a 

Rotational kinetic energy n/a 

Torque Magnitude, X, Y, Z 

Total energy n/a 

Total force Magnitude, X, Y, Z 

Velocity Magnitude, X, Y, Z 

Volume n/a 

Custom property Depends on number of elements 

Bond Normal force Magnitude, X, Y, Z 

Normal moment Magnitude, X, Y, Z 

Tangential force Magnitude, X, Y, Z 

Tangential moment Magnitude, X, Y, Z 

 
* If the attribute is set to Distance you must define a point or plane from which the distance is measured. When distance is 
selected the Define Reference Object section of the pane will be activated. Choose Point or Plane and define its position 
and, for a plane, its distance from the origin.  
 

The x and y axes are related. The attribute you select to measure on the x-axis will limit 
those available to measure on the y-axis. Similarly if the y-axis is configured first the 
attributes available on the x-axis will be limited. 

 

Configuring the Y-Axis 

Click the Y-axis tab then select the element attribute and component to be plotted on the 
y-axis. The attributes available in the list depend on the elements previously selected 
and the attribute to be measured on the x-axis. A component type can also be selected 
for certain attributes to determine which value will be graphed for a particular attribute 
component: For example, maximum, minimum or average particle velocity. Refer to 
Appendix B: Attribute Definitions for more information on attributes. 
 

Element Attribute Components 

Contacts Contact vector 1 Magnitude, X, Y, Z 

Contact vector 2 Magnitude, X, Y, Z 

Distance Define reference object* 

Normal force Magnitude, X, Y, Z 

Normal overlap n/a 

Position X, Y, Z 

Tangential force Magnitude, X, Y, Z 

Tangential overlap n/a 
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Custom property Depends on number of elements 

Collisions Average normal force Magnitude, X, Y, Z 

Average tangential force Magnitude, X, Y, Z 

Distance n/a 

Duration n/a 

Maximum normal force Magnitude, X, Y, Z 

Maximum tangential force Magnitude, X, Y, Z 

Normal energy loss n/a 

Position X, Y, Z 

Relative velocity Magnitude, X, Y, Z 

Relative velocity normal Magnitude, X, Y, Z 

Relative velocity tangential Magnitude, X, Y, Z 

Tangential energy loss n/a 

Total energy loss n/a 

Velocity element A**  Magnitude, X, Y, Z 

Velocity element B Magnitude, X, Y, Z 

Geometry Compressive force n/a 

Distance n/a 

Position X, Y, Z 

Torque Magnitude, X, Y, Z 

Total force Magnitude, X, Y, Z 

Velocity Magnitude, X, Y, Z 

Custom property Depends on number of elements 

 
 
 

Element Attribute Components 

Particle Angular velocity Magnitude, X, Y, Z 

Compressive force n/a 

Distance Define reference object* 

Kinetic energy n/a 

Mass n/a 

Position X, Y, Z 

Potential energy n/a 

Rotational kinetic energy n/a 

Torque Magnitude, X, Y, Z 

Total energy n/a 

Total force Magnitude, X, Y, Z 

Velocity Magnitude, X, Y, Z 

Volume n/a 

Custom property Depends on number of elements 

Bond Normal force Magnitude, X, Y, Z 

Normal moment Magnitude, X, Y, Z 
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Tangential force Magnitude, X, Y, Z 

Tangential moment Magnitude, X, Y, Z 

 
* If the attribute is set to Distance you must define a point or plane from which the distance is measured. When distance is 
selected the Define Reference Object section of the pane will be activated. Choose Point or Plane and define its position 
and, for a plane, its distance from the origin.  
 
** When the axis is measuring the number of particles or number of contacts it is possible to graph either the total number 
of particles/contacts or the total number in a defined range: For example, counting only those particles with a mass 
between 0.1kg and 0.2kg or velocity between 2m/s and 5m/s. When the Total in Range option is selected the Secondary 
Attribute section of the pane is activated. Choose the attribute and component you wish to restrict the range by and enter 
the maximum and minimum values of that range. 

 

Settings 

See Settings on page 99. 

 

Creating a Pie Chart  

A pie chart is a circular diagram divided into 
segments, each representing a category or 
subset of data (part of the whole). The amount 
for each category is proportional to the area of 
the sector. The total area of the circle is 100% 
and it represents the total population that is 
being shown.  
 

For example, the figure below is a pie chart 
which shows the number of collisions, broken 
down by collision type. The largest slice is for 
particle X - particle Y collisions, which account 
for over 40% of the total. 
 

Selecting the Elements to Graph 

The Select Element section is used to determine which elements in your model to collect 
data from.  
 
Choose the group of elements you are 
interested in. For each element type, you 
can choose either to split the data by type 
or selection/bin group and these will form 
the segments (categories) of the pie 
chart.  
 

When Type or Selection Group is 
selected, the categories within that 
selection are listed: For example if 
Contacts > Type are selected, all specific 
contacts are the categories listed: For example, particle x - particle x, particle x - particle 
y and particle y - particle y. Similarly if Contacts > Selection groups is selected, all 
selection and bin groups in your model are the categories listed. All categories within a 
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type or group are included in the chart by default.  A category can be removed by double 
clicking on it and added back by double clicking on it a second time. Categories colored 
green are currently included in the pie chart, those colored black are not. 
 

When the Selection group option is chosen, all selection and bin groups in your model 
are listed. Both the whole group and each individual bin are listed: For example 'bin 
group' (the group name) and 'bin group0', 'bin group1', 'bin group2' (the individual bins).  
When creating a pie chart, exclude the group name to compare the contents of individual 
bins (the bin group encompasses all of the individual bins and therefore accounts for 
100% of the pie chart). For example, the figure below graphs the number of particles in a 
model. It is clear that all particles are contained within the bin group. However, if you 
want to compare how many are in each bin, exclude the whole bin group and just 
examine the individual bins. 

   

 
Figure 4-32: Alternative pie charts 
  

Define Attribute 

Click on the Select Attribute tab and select the element attribute and component you 
want to examine using the pie chart. The attributes available in the list will depend on the 
elements previously selected. The component type available for most attributes is Total 
as this is the only type that can be displayed using a pie chart: For example, the total 
mass of particles of Type A compared to particles of Type B. Refer to Appendix B: 
Attribute Definitions for more information on attributes. 
 

Element Attribute Components 

Contacts Contact vector 1, 2 Magnitude, X, Y, Z 

Normal force Magnitude, X, Y, Z 

Normal overlap n/a 

Number of contacts** n/a 

Tangential force Magnitude, X, Y, Z 

Tangential overlap n/a 

Custom property Depends on number of elements 

Collisions Average normal force Magnitude, X, Y, Z 

Average tangential force Magnitude, X, Y, Z 

Maximum normal force Magnitude, X, Y, Z 

Maximum tangential force Magnitude, X, Y, Z 
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Element Attribute Components 

Normal energy loss n/a 

Number of collisions** n/a 

Relative velocity Magnitude, X, Y, Z 

Relative velocity normal Magnitude, X, Y, Z 

Relative velocity tangential Magnitude, X, Y, Z 

Tangential energy loss n/a 

Total energy loss n/a 

Velocity of element A Magnitude, X, Y, Z 

Velocity of element B Magnitude, X, Y, Z 

 
 

Element Attribute Components 

Geometry Compressive force n/a 

Distance n/a 

Torque Magnitude, X, Y, Z 

Total force Magnitude, X, Y, Z 

Velocity Magnitude, X, Y, Z 

Custom property Depends on number of elements 

Particle Angular velocity Magnitude, X, Y, Z 

 Compressive force n/a 

 Distance Define reference object* 

 Kinetic energy n/a 

 Mass n/a 

 Number of particles** n/a 

 Potential energy n/a 

 Rotational kinetic energy n/a 

 Torque Magnitude, X, Y, Z 

 Total energy n/a 

 Total force Magnitude, X, Y, Z 

 Velocity Magnitude, X, Y, Z 

 Volume n/a 

 Custom property Depends on number of elements 

Bond Normal force Magnitude, X, Y, Z 

Normal moment Magnitude, X, Y, Z 

Number of broken bonds n/a 

Number of intact bonds n/a 

Tangential force Magnitude, X, Y, Z 

Tangential moment Magnitude, X, Y, Z 

* If the attribute is set to Distance you must define a point or plane from which the distance is measured. When distance is 
selected the Define Reference Object section of the pane will be activated. Choose the point or plane from which the 
distance should be measured. A point is defined by its xyz position and a plane by its orientation and distance from the 
origin.  
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Settings 

Two options are set in the Setting tab.  

Time Step 

Pie charts can be created for elements in a particular time step or over a range of time 
steps. By default the Current Time step option is selected. The current time step can be 
changed using the Current Time control in the Viewer control pane at the right of the 
screen. 
 

For example, you could chart the total number of particles in each bin in a bin group at a 
particular time or the total number that have been in the bins over the course of the 
entire simulation. Comparing the charts we can see that at t=0.0021s most particles are 
in bins 09 and 04, however this is not indicative of their location over the course of the 
whole simulation. 

 
 
Unselect the Current Time Step to set a different start and end time. Grayed-out 
timesteps indicate partial saves and may not contain all the data you want to plot. 

Graph Text 

Set the pie chart title. 
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Example Pie Chart of Bin Groups  

A model contains a bin group dividing the model domain into 10 bins. You want to show 
the number of contacts that are occurring in each bin at a given time.  
 

1. Select the element Contact > Selection Groups. 

 
2. Choose the attribute Number of Contacts (Total). 

 
3. Go to the Settings tab and give the chart a title.  

4. Go to the Viewer Controls pane and choose the time step at which you want to 
examine the contacts. Ensure the Current time step option in the Settings tab is 
selected. 

5. Click the Create Graph button. 

6. The pie chart and the percentage breakdown of the number of contacts occurring 
in each bin will be displayed in the Viewer. For example: 
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Running EDEM in Batch Mode 

EDEM’s Command Line Interface (CLI) 

With EDEM’s command line interface, you can run EDEM in batch mode without using 
the GUI. You may want to do this when: 
 

 You have a cluster with limited display capability and want to do grid processing 

 You need to create batch jobs to run EDEM simulations 

 You want to develop advanced scripting for parametric optimization. 
 
The Command Line can also export data to a .csv file once simulation completes. 

Using the Command Line 

The EDEM Command Line has the same flags for both Windows and Linux: 
 
edem.exe –console –i “input.dem” [processing flags][post-processing flags][-h] 

 

For full details, use the –h flag to display the EDEM command line help. 

Processing Flags 

The processing flags set the simulator options such as simulation time, time step, and 
number of processors. You can also specify the license server to use from the command 
line. If you do not specify any processing flags, default values are used. 

Post-Processing Flags 

Use the post-processing flags to specify data export parameters. You can either specify 
the type of data to export (all, particle, geometry, etc.) or specify your simulation’s 
configuration file. 
 
If you want to export data from the command line, first select File > Export > Results 
Data from the Analyst to set the path and filename to export to. 

Command Line Processing Output 

While processing, the EDEM Command Line outputs a row of numbers at regular 
intervals. From left to right, the columns indicate: 

 Number of time steps  
 Simulation time (s) 
 Processing time (s)  
 Expected time to process one second of simulation time (s)  
 Total linear kinetic energy (J) 
 Total rotational kinetic energy (J) 
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Examples 

Example 1: default processing options 

1. Create and save a simulation deck using the EDEM Creator. 

2. Open a console (cmd) window then change directory to the EDEM bin directory. 

3. Type the following: 
 

edem.exe -console -i "c:\My Documents\EDEM\mysim.dem" -rewind  

 

The deck is rewound to the start then each time step is processed. A message is 
displayed once complete. You can then open the deck and use the EDEM Analyst to 
perform any post-processing. 

Example 2: specifying processing options 

1. Create and save a simulation deck using the EDEM Creator. 

2. Open a console (cmd) window then change directory to the EDEM bin directory. 

3. Type the following: 
 

edem.exe -console -i "c:\My Documents\EDEM\mysim.dem" –p 4 –r 10 

 

This command runs the simulation using 4 processors for 10 seconds total run time. 

Example 3: run simulation and export data 

1. Create and save a simulation deck using the EDEM Creator. 

2. Open a console (cmd) window then change directory to the EDEM bin directory. 

3. Type the following: 
 

edem.exe -console -i "c:\My Documents\EDEM\mysim.dem" –rewind –ePC “c:\My 

Documents\EDEM\mysimdata.csv” 

 

This command rewinds then runs the simulation using default processing flags. It then 
exports particle and contact data to a .csv file. 

Example 4: run simulation and export data based on deck configuration 

1. Create and save a simulation deck using the EDEM Creator. 

2. Switch to the Analyst then select File > Export > Results Data. 

3. Define the export queries then set the filename. Click Close. 

4. Switch back to the Creator then save your deck. The configuration file is updated 
with details of the export queries. 

5. Open a console (cmd) window then change directory to the EDEM bin directory. 

6. Type the following: 
 

edem.exe -console -i "c:\My Documents\EDEM\mysim.dem" –rewind –e “c:\My 

Documents\EDEM\mysim.dfg” 

 

This command rewinds then runs the simulation using default processing flags. It then 
exports data based on the queries defined in the deck’s configuration file. 
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Custom Properties 

With custom properties you can dynamically define custom attributes to use in your 
simulation. Custom properties can be graphed and exported just like any other attribute. 
When loaded, contact models, particle body forces, and factories can all use and share 
data about these new custom properties. 
 

Custom Property Category Example 

Contact Contact duration, highest force during contact 

Geometry Wear, shot peening threshold, accumulation 

Particle Residence time, temperature 

Simulation Stickiness of a surface 

 
Note: You must have an EDEM API license to use custom properties. 

Creating a Custom Property 

You can define any number of custom properties by developing plugins that use the 
EDEM API. Refer to the EDEM Programming Guide for details. 

Viewing Custom Properties 

Once a suitable plugin contact model, particle body force or factory is added to your 
simulation, select Tools > Custom Properties to view and edit details for each type of 
custom property. 
 

Attribute Description 

Name The unique name of the custom property. 

State Before simulation begins, custom properties are in a tentative state. 
Once simulation starts the properties become finalized. 

Storage Type The properties data type (currently always a double precision 
floating point number). 

Number of 
Elements 

Indicates the number of elements. Usually a property has one 
element. A property with a position in 3D space would have three 
elements (X, Y, and Z).  

Units The unit type, for example length, temperature, velocity etc. If the 
property has no unit, this is set to None. 

Values Indicates the property’s initial values. Double-click to change the 
value (provided the custom property is either still tentative or is a 
simulation property). For custom simulation properties, the Values 
area also indicates the value for the current timestep. 

 
When simulation starts, tentative properties are finalized. Once a property is finalized, 
you cannot modify or delete it (except for current values of simulation properties).
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Appendix A: Estimating Simulation Time 

Exact estimation of the real time required for a DEM simulation is almost impossible, as 
each simulation and each computer is different. However, see below for some general 
advice on estimating simulation time. 

Time Step 

One of the key numbers in DEM simulation is the Rayleigh time step. This is the time 
taken for a shear wave to propagate through a solid particle. It is therefore a theoretical 
maximum time step for a DEM simulation of a quasi-static particulate collection in which 
the coordination number (total number of contacts per particle) for each particle remains 
above 1. It is given by: 

 

 

where R is the particle’s radius, ρ its density, G the shear modulus and v the Poisson’s 

ratio. In practice some fraction of this maximum value is used, and for high coordination 

numbers (4 and above) a typical time step of 0.2TR (20%) has been shown to be 

appropriate. For lower coordination numbers, 0.4TR (40%) is more suitable.  

Hertzian Contact 

Whilst the Rayleigh time step is a suitable starting point for quasi-static simulations, for 
systems undergoing flow it may be that a shorter time step is required. Consider two 

elements approaching each other at a speed v. In one time step, t, the maximum 

possible overlap is: 

 
 

In DEM, particles undergoing elastic (Hertzian) contact are treated as overlapping and 

this overlap is equated to a surface compression. t in the above equation must be such 

that the maximum overlap is lower than the theoretical maximum overlap for Hertzian 
contact. In practice, to get a good numerical integral to the contact graph at least six time 
points should occur (though then is more desirable) - three during approach and three 
during separation. 

 

Elastic Impact 

From Hertz theory of elastic collision the total time of contact is given by: 
 

 

Where: 
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Where  and  are the mass of the two elements. 
 
 

 

 
Where  and  are the radii of the two elements. 
 

 

 
where  and  are the poisons ratio of the two materials. 
 

 
 
Where  is the relative velocity and  and  are the velocity of the two elements. 
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Appendix B: Attribute Definitions 

Particle Attributes 

Attribute Description 

Angular velocity Angular velocity is defined as the speed at which an object 
rotates.  For a particle of radius r (m) rotating at velocity   

rad/s, V = r  

 
Angular velocity magnitude = sqrt(wx

2 + wy
2 + wz

2) 

Charge Charge is an electrical property of particles (such as electrons 
and protons) which causes them to attract and repel each 
other. A material with an excess of electrons has a negative 
charge; material with an absence of electrons (or an excess of 
protons) has a positive charge. Materials with a balanced 
number of electrons and protons are called 'neutral'. Positive 
and negative charges attract each other. 

Compressive force The compressive force is the sum of the surface normal force 
magnitudes. 

Distance Distance is defined as how far apart the center of a particle is 
from a reference point or plane. 

Electrostatic force Electrostatic force is a force of interaction between charged 
particles, measured in Newtons. In EDEM the force is 
calculated using the screened Coloumb force equation. 

ID A geometry element, particle surface, particle and collision all 
have unique ID numbers. 

Moment of Inertia Inertia is a measure of a particles resistance to a change of 
momentum.  For a sphere I = (2/5).m.r2 

Kinetic energy The kinetic energy is defined by Ke = 0.5 * m * v2 where v is 
the velocity magnitude of the particle. 

Mass The mass of a particle is defined as the magnitude of the 
gravitational force on a particle.  Mass = volume * density.  

Number of particles The number of particles is the total number of particles in a 
simulation (or bin group) at that point in time. In a bin group the 
option of “total over time” can be used.  This will produce a 
cumulative particle count for any particles that pass through 
that bin group.  Please note that the total over time option can 
only be used for bin groups with 1 bin. 

Orientation Orientation is the alignment of a particle in relation to Cartesian 
space. It is represented in EDEM as a 3-by-3 matrix that 
defines the rotation of the particle from its original orientation 
(as defined in the Creator and assigned an identity matrix). 

Position The X, Y, or Z position of the center of the particle. 

Potential energy The potential energy is defined by Pe = m.g.h where m is the 
particle mass, g is gravity and h is the distance between the 
center of mass of the particle and the defined “ground” level.  If 
gravity is acting in –ve Z the ground level is z=0. 
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Attribute Description 

Rotational kinetic 
energy 

The rotational kinetic energy is defined as 0.5 * Inertia * 
(angular velocity magnitude)2.  

Time In EDEM time is the real time it takes for an event to occur. 

Torque The torque on the particles is defined as the tangential contact 
force * particle radius. 

Total energy The total energy of a particle is the sum of the kinetic energy, 
rotational kinetic energy and potential energy of a particle. 

Total force The total force is the resultant unbalanced forces on a particle 
or geometry element in x y and z. 

Velocity The velocity of the particles is defined as the rate of change of 
displacement (in X Y and Z).  

Voidage Voidage is the percentage of space not taken up by particles.  
 
Voidage (%) = 100 * (Bin Volume – Total particle volume in the 
bin) / (bin volume) 
 
Voidage can only be exported from a bin group. Note that the 
total particle volume in the bin is calculated from the bin that 
contains the center of the particle.  A particle which overlaps 
two or more bins will only be counted in the bin that contains 
the particle center of mass. 

Volume The volume of a particle is defined as the amount of space that 
it takes up. 
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Geometry Attributes 

 

Attribute Description 

Charge See Particle Attributes. 

Compressive force See Particle Attributes. 

Distance Distance is defined as how far apart the center of a geometry 
node is from a reference point or plane. 

Electrostatic Force See Particle Attributes. 

ID A geometry element, particle surface, particle and collision all 
have unique ID numbers. 

Node 1,2,3 The position (x, y and z) of the geometry nodes.  

Number of geometry 
elements 

Geometry in EDEM is split into triangular elements.  The 
number of geometry elements is a summation of this. 

Position The X, Y, or Z position of the center of the geometry element. 

Torque The torque on the geometry is defined as the normal contact 
force * distance where the distance is the distance from the 
center of mass to the contact point.  
 
The torque is calculated from the individual torque and 
moment about each individual geometry element.  This is then 
converted to the torque on the whole geometry about the 
center of mass.  The torque can be plotted/exported along the 
X, Y and Z axis. 

Total force The total force is the resultant unbalanced forces on a particle 
or geometry element in x y and z. 

Velocity The velocity of the geometry is defined as the rate of change of 
displacement of the individual geometry nodes. 

 



EDEM 2.4 User Guide 

118 

Contact Attributes 

 

Attribute Description 

Contact vector 1,2 When two particles collide the contact vector is the vector 
connecting the contact point to the center of the particle. 

 
Distance The distance from the point of contact to a user-defined point 

or plane.

 
Normal force The normal force arises when two bodies are in direct contact 

with one another. It always acts perpendicular to the body that 
applies the force. 
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Attribute Description 

Normal overlap The normal overlap represents the normal deformation of a 

particle. The normal overlap N between two particles i and j 

at positions pi and pj with radii ri and rj is defined as: 
 

 
 

 
Number of contacts Contacts are the impacts occurring between elements at data 

write-out points. In other words, the contact is in progress 
when the write-out takes place. The contact has an associated 
force, position and so on - these are discrete values. If two 
elements stay in contact with each other for some time e.g. 
over four write-out points, four contacts will be stored and 
each of these may have a different force, position and so on. 

Position The central point between two elements at the point in time 
when a contact starts. 

Tangential force The tangential force is the force from the tangential overlap. 

 
Tangential overlap The tangential displacement of the contact point up to the 

point at which the contact ends or the particle begins to roll or 
slip. The tangential overlap represents the tangential 
deformation of a particle. 

Time In EDEM time is defined as the real time it takes for an event 
to occur. 
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Collision Attributes 

 

Attribute Description 

Average normal force The average normal force over the duration of a single 
collision. 

Average tangential force The average tangential force over the duration of a single 
collision. 

Distance Defined as the distance from the collision position to a 
user defined point or plane.  Distance from the collision 
position to the point (10,0,-12.05) mm is 10 mm. 
 

 
 

Duration Collision duration is the total time that the two elements 
involved in a collision are in contact. 

End time The end time is the time at which the collision ends. 

ID Each collision has a unique number which can be used to 
track the unique collision and the elements involved. 

ID Element n Each element in a collision has a unique number. 

Maximum normal force The maximum normal force experienced during a single 
collision. 

Maximum tangential force The maximum tangential force experienced during a 
collision. 

Normal energy loss The energy lost during a collision due to the normal 
overlap. 

Number of collisions The number of completed collisions. Only completed 
collisions are counted: collisions in progress (contacts) 
are not counted. 

Position The central point between two elements at the point in 
time when a collision starts. The collision position is 
written out on completion of the collision. 

Relative velocity Relative velocity of two elements in a collision is Va - Vb 

Relative velocity normal Relative normal velocity of two elements in a collision is 
Vna - Vnb 

Relative velocity 
tangential 

Relative tangential velocity of two elements in a collision 
is Vta - Vtb 

Start time Defined as the point in time when the first contact of a 
collision occurs. 
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Attribute Description 

Tangential energy loss Energy lost during a collision due to the tangential 
overlap. 

Time In EDEM, time is defined as the real time it takes for an 
event to occur. 

Total energy loss The sum of the normal and tangential energy loss. 

Velocity of element A/B The velocity magnitude of an element involved in a 
collision, element A will have the lowest ID number and 
element B will have the highest. 

 

Bonding Attributes 

Attribute Description 

End Time The point at which a bond breaks. 

Normal Force The resultant normal force experienced by the bond. 

Normal Moment The normal moment applied to the center of the cylindrical 
bond. 

Number of Broken Bonds The total number of broken bonds in the simulation. 

Number of Intact Bonds The total number of intact bonds in the simulation. 

Start Time The point in time at which the bond was created. 

Tangential Force The resultant tangential force experienced by the bond. 

Tangential Moment The tangential moment applied to the center of the 
cylindrical bond. 
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Appendix C: EDEM File Types 

EDEM Files 

File Type Description 

.dem Data file Simulation data. One of three files created for every 
model. It is also created when you export a particle. 

.dfg Config file Configuration information for the simulation. This is 
one of three files created for every model. It is also 
created when you export a particle. EDEM 2.4 
automatically converts the .dem.cfg config file 
format to the .dfg format. 

.dem.scn.n Data file Additional EDEM simulation data. A .dem.scn.n file 
(where n is a number) is created whenever the 
.dem file reaches approx. 1.5 GB in size. 

.dll Library EDEM uses dll library files for contact models, 
particle body forces, and user-defined factories. 
Use Tools > Options > File Locations to change dll. 

.ess Data file EDEM simulation settings. Binary file that stores 
per-simulation data for selections, custom 
properties, and field information (if applicable). 

.idx Index file Index for the .dem file. Also created when you 
export a particle. 

materialsDB.ddb Materials 
database 

The materials database is used to define any 
material used in a model. Use Tools > Options > 
File Locations to change its location. 

.ptf Particle 
template 

The particle template file contains mesh 
information. It is created whenever you save a 
model containing a particle template. 
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EDEM Standard Supported Filetypes 

File Extension Type Source Software Application 

.case Data EnSight 

.csv Data Any spreadsheet or other software application 
that can read text files 

.igs, .iges Geometry IGES 

.msh Geometry1 FLUENT Mesh 

.stl Geometry STL 

.stp, .step Geometry STEP 

1 
Enabled with EDEM-CFD Coupling for FLUENT 

 

EDEM Optional Supported Filetypes 

File Type Source Software Application 

.cgns Data1 CFD software applications that can read the 
generic CFD General Notation System format. 

For example, FLUENT, CFX, and STAR-CD 

.CATPart, 

.CATProduct, .model 

Geometry Catia v4/v5 

.dxf, .dwg Geometry AutoCAD 

.prt, .asm, .g Geometry2 Pro/E 

.sat Geometry ACIS 

.vda Geometry Various CAD software applications 

.x_t, .xmt_txt, .x_b Geometry Parasolid 

1 
Enabled with the Field Data Coupling Module 

2 
Pro/E import is Windows-only 
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Technical Support 

 
DEM Solutions is committed to providing you with quality software. If at any time you 
experience problems with EDEM, please contact our support group: 
 

E-mail:  support@dem-solutions.com

mailto:support@dem-solutions.com


Glossary 
 

Glossary 

B 

BCC Lattice: In a body-centered cubic (BCC) lattice there is one particle at each corner 
of a cubic unit cell and one particle in the cell center. The packing efficiency of a 
BCC lattice is considerably higher than that of a simple cubic lattice. See also 
Cubic Lattice. 

 

C 

CAD: Computer-aided design. 

CAE: Computer-aided engineering. 

CFD: Computational fluid dynamics. 

Coefficient of Restitution: The coefficient of restitution is the ratio of speed of 
separation to speed of approach in a collision. 

Coefficient of Rolling Friction: When a body rolls on a surface, both the body and the 
surface can deform to oppose this rolling motion. This is usually represented as a 
torque being applied to each of the bodies. The coefficient of rolling friction is a 
scalar value used to determine how much torque is needed to be applied to an 
object of a given material at rest on a flat surface to put it into motion. 

Coefficient of Static Friction: The coefficient of static friction is a scalar value used to 
determine how much force is required before an inert object, of a given material, 
at rest on another known substance, can be put into motion.  

Coordination Number: The total number of contacts in a simulation. 

Cubic Lattice: The cubic lattice is defined by setting the start point, separation and 
rotation. The start point is the point in the domain where the lattice will be drawn 
from. The separation is the distance between each corner node in the lattice. 
This can be defined for each dimension. The rotation is the angle at which the 
entire lattice is tilted. The simulator will attempt to place a particle at every node, 
side center and cell center on or in the chosen section. The center of each cell 
and side is not marked when the lattice is displayed in the Viewer. For example, 
the figures below are the same model each with a different lattice. 
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The lattice has been given a start point to just 
within the domain boundaries. The separation 
distance in each direct is quite small leading to a 
dense lattice. 

The lattice has been given a start point to coincide 
with the geometry. The separation distance in each 
direction is larger and will result in less particles 
being placed on the surface. 

D 

DEM: (1) Discrete element method; (2) Discrete element modeling; (3) Distinct element 
modeling. 

Density: The density of a body is the weight per unit volume. 

Dynamic Section: Sections can be static or dynamic. Dynamic sections move during 
the course of a simulation. 

Dynamic Factory: A dynamic factory produces particles over the course of a simulation. 
You can define the total number of particles to be created, the creation rate and 
the creation start time. 

F 

Facet Length: The facet length is the maximum length of a facet edge. 

Facet Sag: The facet sag is the distance between the curved body surface and the 
facet. 

FCC Lattice: In a face-centered cubic (FCC) lattice there is one particle at each corner 
of a cubic unit cell and one particle in the center of each face. The packing 
efficiency of a FCC lattice is considerably higher than that of both a simple cubic 
lattice and a body centered cubic lattice. See also Cubic Lattice. 

 

FEA: Finite element analysis. 

Fixed Time-step: A fixed time step remains constant through the simulation. 
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H 
Hertz-Mindlin (no slip) with RVD Rolling Friction: A model that provides relative 

velocity-dependent rolling friction and ensures the same torque being applied to 
each of the particles in contact.  

Hertz-Mindlin with JKR Cohesion: A cohesion contact model that allows users to edit 
the cohesive quality of sticky materials, especially fine dry powders with particles 
sized 100 microns or less. The model can also be successful in modeling wet 
grains.  

Hysteretic Model: A model that allows plastic deformation behaviors to be included in 
the contact mechanics equations, resulting in elastic-plastic deformation 
behavior.  

I 

Simulation Deck: An EDEM simulation usually consists of four files: a *.dem, *.dfg, *.idx 
and *.ptf file. All simulation data is held within the .dem file. The .dfg and .idx files 
contain configuration and index information. If the .idx and .dfg files are not 
available, they will automatically be created by EDEM when the .dem file is 
loaded. The *.ptf file contains details of any particle templates imported into your 
model. 

L 

Log-normal Distribution: The log-normal distribution is the probability distribution of 
any random variable whose logarithm is normally distributed. If x is a random 
variable with a normal distribution, then exp(x) has a log-normal distribution. 

N 

Normal Distribution: Normal distribution is a theoretical frequency distribution with a 
finite mean and variance. A probability density function is used to represent the 
distribution in terms of integrals. It is usually represented by a bell-shaped 
curved, symmetrical about the mean. This is called the normal curve. 

O 

Orientation Matrix: Non-spherical particles have their own three-dimensional co-
ordinate system. This is necessary to define the position and orientation of the 
spheres making up the particle surface. The orientation matrix describes the 
transformation of a co-ordinate to a new position. Refer to the online help for 
more detail. 

P 

Particle Factory: Used to define where, when and how particles appear in a simulation. 

Physical Section: A physical section of geometry is an actual surface or volume that 
particles can interact with. 
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Poisson's Ratio: Poisson's ratio is the ratio of transverse contraction strain to 
longitudinal extension strain in the direction of stretching force. 

S 

Shear Modulus: Shear modulus (G) is defined as the ratio of shear stress (F) to the 
shear strain (A) i.e. G = F / A, where shear stress is the components of stress at a 

point that act parallel to the plane in which they lie, and shear strain is the 
components of a strain at a point that produce changes in shape of a body 
(distortion) without a volumetric change. 

 

 

Simple Cubic Lattice: In a simple cubic lattice there is one particle at each corner of a 
cubic unit cell. See also Cubic Lattice. 

 

Simulation Time: The simulation time is the amount of real time your simulation 
represents. The number of iterations required to complete a simulation of a 
defined time is displayed at the bottom of the Simulation Time section. 

Static Factories: A static factory produces particles at a specified time. Simulation is 
paused whilst this takes place. 

T 

Time Step: The amount of time between iterations (calculations). 

V 

Virtual Section: A virtual section is a surface or volume that does not actually exist and 
does not interact with anything in a simulation. Virtual sections are usually used 
to create particle factories. 

W 

Work Function: The work function is the minimum energy (measured in electron volts) 
needed to remove an electron from a solid to a point immediately outside the 
solid surface. 
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Electrostatics ...................................... 21 
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